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REGISTER THIS BOOK, THEN DOWNLOAD 
PHOTOS FOR FREE!
Purchasing this book entitles you to more than just a 
couple of pounds of paper. If you register the book with 
Peachpit Press, you will also be entitled to download 
copies of many of the images that are used throughout 
the book, which you can use to practice with as you 
follow our step-by-step tutorials. 

To access the bonus images, log into your Peachpit 
account or create one at Peachpit.com/join (it’s free). 
On your Account page (under the Registered Products 
tab), click Register Your Products Here or Register 
Another Product, enter the ISBN number for this book: 
0321929527, then click Submit. Finally, below the title 
of this book, click the Access Bonus Content link.

Note: The downloadable images that we have made avail-
able are low resolution (not suitable for printing), and 
they are copyrighted by their owners, who have water-
marked them to discourage unauthorized reproduction. 
They are for your personal use only — not for distribution 
or publication.

NOTE TO OUR READERS
Before going to press with this book, we tested (and 
retested) our text to ensure that it accurately describes 
the options and features we viewed in the prerelease 
version of Photoshop CC. Due to the nature of the 
Creative Cloud, however, some features may change 
or update at a later date. If there are any significant 
changes to Photoshop, we will post an addendum in the 
Access Bonus Content link at Peachpit.com, so be sure to 
register your book (see the directions above). Also, you 
can find supplemental information about Photoshop on 
our blog at elaineandpeter.com. 
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Using the powerful and wide-ranging 
controls in the Adobe Camera Raw plug-in, 
you can apply corrections to your photos 
before opening them into Photoshop. In this 
comprehensive chapter, you’ll learn how to open digi-
tal photos into the Camera Raw dialog and correct for 
defects, such as poor contrast, under- or overexposure, 
color casts, blurriness, under- and oversaturation, geo-
metric distortion, color fringes, and noise. You will also 
learn how to enhance your photos with special effects, 
such as a vignette, grain texture, or tint; merge multiple 
exposures of the same photo; retouch blemishes; save 
and synchronize Camera Raw settings among related 
photos; and of course, open your photo into Photoshop.

Note: The Camera Raw plug-in, which we refer to simply 
as “Camera Raw,” is included with Photoshop. Some 
users also refer to the plug-in as “ACR,” short for Adobe 
Camera Raw.

Why use Camera Raw?
Amateur-level digital cameras store images in the JPEG 
or TIFF format, whereas advanced amateur and pro 
models offer the option to save images as raw data files, 
which offers substantial advantages. Cameras apply 
internal processing to photos that are captured as JPEG 
or TIFF, such as sharpening, automatic color adjustments, 
and a white balance setting. With raw files, you get only 
the original raw information that the lens captured onto 
the camera’s digital sensor, leaving you with full control 
over subsequent image processing and correction.

These are some basic facts about Camera Raw:

 ➤ Camera Raw can process raw, TIFF, and JPEG photos 
from most digital camera models.

 ➤ Camera Raw offers powerful controls for correcting 
problems in your photos, such as over- and under-
exposure and color casts, and for applying enhance-
ments, such as a vignette or a grain texture.

 ➤ Camera Raw saves edits to TIFF and JPEG files in 
the file itself, whereas edits to raw files are saved 
as instructions (in a separate “sidecar” file or in the 
Camera Raw database). When you open a photo 
from Camera Raw into Photoshop, the instructions 
are applied to a copy of the file, and the original raw 
file is preserved.

 ➤ To any image layer in Photoshop, you can apply 
some Camera Raw features via the Filter > Camera 
Raw Filter command.★
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CAPTURING TONAL VALUES: YOUR CAMERA VERSUS THE HUMAN EYE

A The digital sensor in a camera captures tonal values 
in a linear fashion, from light to dark, without altering 
the incoming data. A light value of 50% is located at the 
midpoint of the tonal range.

50% light value

B Camera Raw redistributes some of the captured tonal 
values to the shadows and midtones, shifting the 50% 
light value past the midpoint. As a result, the lower tonal 
values — the range the human eye tends to be more sen-
sitive to — contain more data.

50% light value

More reasons to use Camera Raw

In case you’re not fully sold on the benefits of cor-
recting your digital photos in Camera Raw before 
opening them into Photoshop, consider these points: 

Ability to preview raw files: The only way to preview 
a raw photo is in Camera Raw (or other software that 
converts raw files). Note: The photo that you view 
on the LCD screen of your digital camera is merely a 
JPEG preview of the raw capture, not the “actual” raw 
capture.

Great correction features: Camera Raw offers many 
unique adjustment controls that you simply won’t 
find in Photoshop. 

Less destructive edits: When applying corrections to 
a photo, the goal is to preserve as much of the image 
quality as possible. Adjustments that you make to a 
photo in Camera Raw (and that are applied automat-
ically when the photo is opened in Photoshop) cause 
less data loss than similar adjustment commands in 
Photoshop. 

Preserves 16 bits per channel: To preserve more of 
the original pixel data in a raw photo, Camera Raw 
keeps the bit depth as 16 bits per channel. This helps 
offset the data loss from subsequent image edits in 
Photoshop, and results in a better-quality photo.

Tonal redistribution: The sensor in a digital camera 
captures and records the existing range of tonal 
values in a scene as is, in a linear fashion, without 
skewing the data toward a particular tonal range.A 
That sounds fine on paper, but the reality is that the 
human eye is more sensitive to lower light levels 

than to higher light levels. In other words, we’re  
more likely to notice if shadow areas lack detail and 
less likely to notice extra details in highlight areas. 
The result is that digital photos typically contain 
more data than necessary for the highlight values in 
a scene and insufficient data for the lower midtone 
and shadow values. In a Camera Raw conversion, 
data is shifted more into the midtone and shadow 
ranges of your photo. This not only helps compen-
sate for the peculiarities of human vision, but also 
helps prepare your photos for subsequent image 
edits in Photoshop.B If you apply tonal adjustments 
in Photoshop to a photo that contains insufficient 
shadow data, the result is posterization and a notice-
able loss of detail; if you apply the same edits to 
a good-quality photo that has been converted in 
Camera Raw, the destructive edits will be far less 
noticeable.

Superior noise reduction and sharpening: Not 
to knock Photoshop, but the noise reduction and 
sharpening features in Camera Raw cause less data 
loss than similar features in Photoshop.

Learning the Camera Raw features will give you a 

head start: The tonal and color controls in Camera 
Raw are similar to many of the adjustment con-
trols in Photoshop (e.g., Levels, Curves, and Hue/
Saturation) that are discussed in later chapters. As 
you proceed through the lessons in this book, you 
will apply and build on the skills you have mastered 
in this chapter. 
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Raw, JPEG, or TIFF?

Unfortunately, Camera Raw can’t correct deficiencies 
in digital JPEG and TIFF photos as fully as it can in 
raw photos, for several reasons. First, cameras reduce 
digital JPEG and TIFF photos to a bit depth of 8 bits 
per channel, and in so doing discard some of the 
captured pixels. Cameras save raw photos at a bit 
depth of 16 bits per channel, and preserve all the 
captured pixels. 

Second, cameras apply color and tonal corrections 
to JPEGs and TIFFs (called “in-camera” processing). 
Camera Raw must reinterpret this processed data, 
with less successful results than when it has access 
to the raw, unprocessed data. 

All of the above notwithstanding, if your camera 
doesn’t shoot raw photos or you acquire JPEG or TIFF 
photos from other sources, you can still use practi-
cally all of the outstanding correction and adjust-
ment features in Camera Raw to process them. 

Note: In this chapter, we focus only on processing 
raw and JPEG files in Camera Raw — not TIFF files. 
The JPEG format is mentioned only when a particular 
feature treats a JPEG differently than a raw file.

 ➤ Factoid: Each digital camera manufacturer cre-
ates its own version of a raw file and attaches a 
different extension to the names of its raw files, 
such as .nef for Nikon and .crw or .cr2 for Canon.

JPEG …
JPEG advantages

 ➤ JPEG files have a smaller storage size than raw 
files, so your digital camera can store more of them. 

 ➤ In sports, nature, and other fast-action photog-
raphy, speed is a necessity. Photo sequences can 
be captured more rapidly as JPEG files (due to their 
smaller storage size) than raw files. 

 ➤ Most software programs can read JPEG files, but 
only a few programs can read raw files.

JPEG drawbacks
 ➤ The JPEG format discards some captured pixels 

due to its lower bit depth of 8 bits per channel.

 ➤ The JPEG compression methods destroy some 
image data and can produce defects, such as arti-
facts, banding, and loss of detail. 

 ➤ The pixel data in JPEG photos is processed inter-
nally by the camera. Although Camera Raw can be 
used to improve your JPEG photos, it won’t have 
access to the original pixel data (nor will you).

… COMPARED TO RAW
Raw advantages

 ➤ The raw compression methods are nondestructive. 

 ➤ Raw files have a higher bit depth of 16 bits per 
channel.

 ➤ Raw files contain the original, unprocessed pixel 
data and full range of tonal levels that were cap-
tured by the camera. Camera Raw is given all that 
image data to work with, and the result is a higher-
quality image — even after adjustments.

 ➤ Because the white point setting isn’t applied to 
your raw photo (it’s merely stored in the metadata 
of the file), you can adjust that setting at any time in 
Camera Raw. 

 ➤ Camera Raw does a better job of redistributing 
tonal values in raw files than in JPEG files, making 
raw files better candidates for Photoshop edits.

Raw drawbacks
 ➤ Raw files have larger storage sizes than JPEG files.

 ➤ Digital cameras create and store raw files more 
slowly than JPEG files, a potential drawback in 
fast-action photography (although as camera tech-
nology improves, this may become less of an issue).

The bottom line
Despite the faster speed and smaller storage sizes of 
JPEG files, raw files have more advantages.

KEEPING CAMERA RAW UP TO DATE
Of the many proprietary raw “formats” in the 
universe, some are unique to each manufacturer 
(such as Nikon or Canon) and some are unique to 
each camera model. To ensure that Camera Raw is 
using the latest interpreter for your camera, visit 
www.adobe.com periodically, and download and 
install any Camera Raw updates that are posted for 
your camera model.

http://www.adobe.com
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RECOGNIZING THE BADGE
In Bridge, the thumbnail for a file that has been 
opened and edited previously in Camera Raw will 
display this badge   in the upper-right corner, and 
the thumbnail and preview will reflect the current 
settings. Another clue: If the currently selected file 
has been edited in Camera Raw, you will see a Camera 
Raw category in the Metadata panel.

Opening photos into Camera Raw
For a smooth workflow, we recommend setting the 
proper preferences so your raw photos (and JPEG 
or TIFF photos, if any) will open directly into Camera 
Raw.

To set a preference so your raw photos 
open directly into Camera Raw:

1. In Photoshop, go to Edit/Photoshop > Preferences  
(Ctrl-K/Cmd-K) > File Handling. 

2. Under File Compatibility, check Prefer Adobe 

Camera Raw for Supported Raw Files, then click 
OK. When you double-click a raw file, it will open 
into Camera Raw (as opposed to other software 
that can be used to convert raw files).

To set a preference so your JPEG or TIFF 
photos open directly into Camera Raw:

1. In Bridge, choose Edit/Adobe Bridge CC > Camera 

Raw Preferences. 

2. At the bottom of the dialog, from the JPEG menu, 
choose Automatically Open JPEGs with Settings.

3. If you shoot digital TIFF photos, from the TIFF 
menu, choose Automatically Open TIFFs with 

Settings; or if you shoot only raw or JPEG photos 
(not TIFF photos), choose Disable TIFF Support.

4. Click OK. 

 When you want to open a JPEG or TIFF photo into 
Camera Raw that has not yet been edited (doesn’t 
have Camera Raw settings), click the thumbnail 
in Bridge, then click the Open in Camera Raw 
button   or press Ctrl-R/Cmd-R. 

 To open a JPEG or TIFF photo that has been 
edited previously in Camera Raw (that is “with 
Settings”), double-click its thumbnail or press 
Ctrl-R/Cmd-R.

 ➤ If you enable both “Automatically Open” options 
(steps 2–3, above), but there is an occasion when 
you want to open a JPEG or TIFF photo directly 
into Photoshop instead of Camera Raw, click the 
thumbnail, then press Ctrl-O/Cmd-O. This shortcut 
will work only if the file hasn’t yet been edited in 
Camera Raw.

 ➤ If the Open in Camera Raw button  is available 
when you click a thumbnail in Bridge, it’s a sign 
that the file can be opened into Camera Raw.

You can set a preference to have either Bridge or 
Photoshop host the Camera Raw plug-in when you 
open a raw or JPEG photo. In the case of Photoshop, 
the program will launch, if it’s not already running. 
Also, when Bridge is the host for Camera Raw, the 
default (highlighted) button for exiting that dialog 
is labeled Done, whereas when Photoshop is the 
host for Camera Raw, the default exit button is Open 
Image or Open Object, depending on a setting in the 
Workflow Options dialog (see step 7 on page 60).

To choose a host for Camera Raw:

1. In Bridge, choose Edit/Adobe Bridge CC >  
Preferences (Ctrl-K/Cmd-K), then show the 
General pane.

2. Check Double-Click Edits Camera Raw Settings 

in Bridge if you want Camera Raw to be hosted 
by Bridge when you double-click a thumbnail in 
Bridge (a raw photo or a JPEG that was previously 
edited in Camera Raw), or uncheck this option to 
have the file open into Camera Raw hosted by 
Photoshop. Click OK.
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After setting the necessary preferences, and before 
learning the particulars of Camera Raw, you should 
familiarize yourself with this basic workflow.

To open a raw or JPEG digital photo into 
Camera Raw:

1. Launch Bridge, display the thumbnail for a raw or 
JPEG photo, then do either of the following:

 For a raw photo, double-click the thumbnail. 

 For a raw or JPEG photo, click the thumbnail, then 
press Ctrl-R/Cmd-R or click the Open in Camera 

Raw button on the Bridge toolbar   (or right-
click the photo and choose Open in Camera Raw).

 ➤ To open a file from the Mini Bridge panel in 
Photoshop into Camera Raw, right-click the 
thumbnail and choose Open With > Camera 
Raw from the context menu.

2. The Camera Raw dialog opens.A An alert 
symbol   may display in the upper-right corner 
of the preview while Camera Raw reads in the 
image data, and will disappear when it’s done. 

 Information about your photo (taken from the 
metadata that was embedded into it by the 
camera) is listed in several locations: the camera 
model in the title bar at the top of the dialog; the 
file name below the preview; and the camera set-
tings used to take the photo (aperture, shutter 
speed, ISO, and focal length) below the histogram.

 The adjustment features are located in 10 
tabs: Basic, Tone Curve, Detail, HSL/Grayscale, 
Split Toning, Lens Corrections, Effects, Camera 
Calibration, Presets, and Snapshots. Switch among 
the tabs to correct your photo (we cover most  
of the tabs in depth in this chapter).

3. When you’re done correcting the photo, you can 
either click Open Image to open the photo into 
Photoshop or click Done to close Camera Raw 
without opening the photo. In either case, the 
Camera Raw settings will stick to the photo, and 
the original data will be preserved. (Note: If you 
want to open the photo into Photoshop as a 
Smart Object, see the Note on page 94.)

A The Camera Raw dialog

Link to the Workflow Options dialog (see page 60)

The original 
camera 
settings

Tabs (click to 
access settings)

Camera Raw 
Settings menu

Toolbox Toggle Full Screen Mode/previous dialog size (F)

Histogram

Zoom controls
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A file that you open from Camera Raw into Photoshop 
as a Smart Object can be reedited using the full array 
of features in Camera Raw at any time. A standard 
image layer in a Photoshop document can also be 
edited using most — but not all — of the Camera  
Raw features by way of the Camera Raw Filter, as 
described in the task below. If you convert the image 
layer to a Smart Object first (an optional step), you  
will be able to edit the filter settings at any time.  
Note: To learn about layers, which are used in this task, 
see Chapter 8. To learn more about Smart Objects,  
see pages 262–269. See also the Note on page 94.

Among the Camera Raw features that aren’t avail-
able via the Camera Raw Filter are the Crop and 
Straighten tools, the rotate buttons, the Workflow 
Options dialog, the Snapshots tab, and some options 
on the Camera Raw Settings menu. Don’t be dissuaded 
by this list of “nos,” however — the filter gives you 
access to the essential Camera Raw features.

To open and edit a Photoshop image layer 
in Camera Raw: ★
1. In an RGB document in Photoshop, display the 

Layers panel.  Click the image layer (or the 
Background) that you want to edit in Camera Raw, 
then press Ctrl-J/Cmd-J to duplicate it. Keep the 
duplicate layer selected.A

2. Optional (but recommended): To keep your Camera 
Raw settings editable, choose Filter > Convert for 
Smart Filters, or right-click the duplicate image 
layer and choose Convert to Smart Object.B If an 
alert dialog appears, click OK. 

3. With the image layer or Smart Object selected, 
choose Filter > Camera Raw Filter (Ctrl-Shift-A/
Cmd-Shift-A).

4. The image layer opens in Camera Raw. Apply the 
needed corrections. 

5. Click OK (a progress bar may display while the 
filter is processing). 

6. If you applied the filter to a Smart Object, on the 
Layers panel, you will see a Camera Raw Filter 
listing below a Smart Filters listing.C To edit the 
Camera Raw settings at any time, double-click 
the Camera Raw Filter listing. To learn more about 
Smart Filters, see pages 362–366.

 ➤ To create a document via the Merge to HDR Pro 
command, then adjust the new document via the 
Camera Raw Filter, see pages 248–251.

CAMERA RAW FILTER OR PHOTOSHOP?
Although we sing the praises of Camera Raw in the 
first two pages of this chapter and strongly recom-
mend using it as a first step before opening a photo 
into Photoshop, Photoshop is no slouch when it 
comes to adjustment options. In fact, Photoshop has 
some commands and features that you won’t find in 
Camera Raw, such as adjustment layers. You can eas-
ily hide, show, clip, or restack any adjustment layer; 
edit its layer mask; and change its opacity or blending 
mode (see Chapter 12). Fortunately, you don’t have to 
decide between Camera Raw and Photoshop — you 
can use both!

A We duplicated 
an image layer.

B We converted 
the duplicate layer 
to a Smart Object.

C We applied the 
Camera Raw Filter  
to the Smart Object. 
A Smart Filters listing 
appeared below the 
Smart Object.
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The Camera Raw tools A
In the upper-left corner of the dialog, click the Zoom 
tool,  then click the image preview to zoom in or 
Alt-click/Option-click it to zoom out. 

Use the Hand tool   to move a magnified preview 
image in the window (if another tool is selected, hold 
down the Spacebar for a temporary Hand tool).

For the White Balance tool,  see the sidebar on 
page 62.

Choose the Color Sampler tool,  then click in the 
image preview to place up to nine samplers. A break-
down of the RGB components below each sampler 
in the photo displays in a readout below the tool box; 
the readouts will update as you make color and tonal 
adjustments. To reposition a sampler, drag it with the 
Color Sampler tool. To remove a sampler, hold down 
Alt/Option and click it. To remove all samplers, click 
Clear Samplers.

For the Targeted Adjustment tool  (or TAT for 
short),  see pages 68–69 and 73.

For the Crop  tool, see page 58.

For the Straighten  tool, see page 59.

For the Spot Removal  tool, see page 90.

The Red-Eye Removal tool  works like the Red-Eye 
tool in Photoshop (for the latter, see page 307).

For the Adjustment Brush tool,  see pages 74–76.

For the Graduated Filter tool,  see pages 86–87.

For the Radial Filter tool,  ★see pages 88–89.

Note: If tool settings are displaying on the right side 
of the Camera Raw dialog (if, say, you were using the 

Adjustment Brush tool) and you want to redisplay 
the row of tab icons, click one of the first seven tools.

 ➤ The tools in Camera Raw are “memory-loaded,” 
meaning that you can toggle them. Press a tool 
shortcut to select a different tool, then press the 
same key again to return to the original tool.

Other buttons at the top of the dialog:

 ➤ The Open Preferences Dialog button    
(or press Ctrl-K/Cmd-K) opens the Camera Raw 
Preferences dialog.

 ➤ The Rotate 90° Counterclockwise  button   
and the Rotate 90° Clockwise button  rotate 
the image. The results preview in the dialog.

MORE WAYS TO ZOOM IN THE PREVIEW
 ➤ Hold down Alt/Option-Spacebar and click to 

zoom out, or hold down Ctrl/Cmd-Spacebar and 
click to zoom in.

 ➤ Press Ctrl –/Cmd – (hyphen) to zoom out or 
Ctrl- +/Cmd- + to zoom in.

 ➤ Use the zoom buttons (– or +) or the Zoom 
Level menu, located below the image preview.

 ➤ Double-click the Zoom tool to set the zoom 
level to 100%.

 ➤ Double-click the Hand tool to fit the image in 
the preview window.

A The shortcuts for the Camera Raw tools are listed in boldface above.

Z Zoom: 
Reduces or 
magnifies 
the preview

H Hand: Moves a 
magnified preview 
in the window

I White 
Balance: Sets 
the white 
balance

S Color Sampler:
Places up to nine  
RGB color sampler 
points in the preview

C Crop: Crops 
the photo based  
on a marquee 
you drag

A Straighten:
Straightens the 
photo along a  
line you drag

B Spot 
Removal: 
Heals 
imperfections

E Red-Eye 
Removal: Corrects  
red-eye in a 
portrait photo

T Targeted 
Adjustment:   
Applies adjust-
ments where 
you drag in  
the preview

Graduated Filter G and 
Radial Filter J tools:  Apply 
edits gradually across an 
area that you designate

Opens the 
Camera Raw 
Preferences 
dialog

K Adjustment  
Brush: Applies 
local edits to 
areas you have 
masked

L Rotate 90° 
Counter- 
clockwise: 
Rotates  
the image

R Rotate 90° 
Clockwise: 
Rotates the 
image
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Cropping and straightening 
photos
With the Crop and Straighten tools, you can control 
which portion of a photo opens into Photoshop. You 
can readjust the crop box at any time without losing 
any image data, and the outlying areas will remain 
available even after you click Save, Done, or Open.

To crop a photo:

1. Open a photo into Camera Raw A (see step 1 on 
page 55). 

2. Choose the Crop tool  (C).

3. Drag in the preview to make a crop box appear.B
4. Optional: To move the crop box, drag inside it. To 

resize the box, drag a handle.

5. To preview the results of the Crop tool, press 
Enter/Return or click any tool except the Crop or 
Straighten tool.C

 ➤ To redisplay the current crop box after exiting 
crop mode, click the Crop tool. If you want to 
remove the box and redisplay the whole image, 
press Esc.

B With the Crop tool, we drew a crop box in the preview 
window. Here, we are resizing the box.

C We pressed Enter/Return to preview the results.

A This is the original photo, in Camera Raw.
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To straighten a crooked photo:

1. Open a photo into Camera Raw (see step 1 on 
page 55). 

2. Choose the Straighten tool  (A).

3. Drag along an edge in the photo that you want 
to align to the horizontal or vertical axis.A A 
crop box will display, aligned to the angle you 
drew.B 

4. To preview the straighten results, press Enter/
Return or click any tool except the Crop or 
Straighten tool.C 

 ➤ To change the straighten results after exiting 
crop mode, choose the Straighten tool (A), then 
drag again. If you want to remove the crop box, 
choose the Crop tool (C), then press Esc.

B A crop box displays. C We pressed Enter/Return to preview the results.

A With the Straighten tool, we are dragging along 
an edge that we want to align to the vertical axis.
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Choosing default workflow settings
Via the Workflow Options dialog, you can resize or 
sharpen a photo, or change its color space or bit 
depth, before opening it into Photoshop (the original 
raw or JPEG file isn’t altered). Your choices will become 
the new default settings. 

To choose default workflow settings:

1. Open a photo into Camera Raw, then at the 
bottom of the dialog, click the underlined link that 
lists the color space, bit depth, etc. The Workflow 

Options dialog opens.A
2. From the Space menu, choose a color profile to 

be used for converting the raw file to RGB: Adobe 
RGB (1998), ColorMatch RGB, ProPhoto RGB, or 
sRGB IEC61966-2.1 (or “sRGB,” for short). In Chapter 
1, you assigned Adobe RGB (1998) as the default 
color space for color management, so for optimal 
color consistency, you should choose it here, too.

3. From the Depth menu, choose a color depth of 
8 Bits/Channel, or if you have a large hard disk and 
a fast system with a lot of RAM, you can choose 
16 Bits/Channel (see page 17). With those extra 
pixels, the photo will retain more of its original 
tonal levels when it’s edited in Photoshop.

4. If you need to resize the image, from the Size 
menu, choose a preset size (in megapixels); all the 
sizes that are listed have the same proportions as 
the raw image (the original size is the one without 
a minus sign [–] or plus sign [+] ). Resampling will 
occur if you choose a different size than the origi-
nal. To help prevent loss of detail, avoid choosing 
the largest size. If the photo has a crop box, the 

Size menu will be labeled as Crop Size, and it will 
list the current crop size. 

 ➤ Alternatively, you can alter the dimensions 
(and/or resolution) of any photo via the Image 
Size dialog after opening it into Photoshop. 
See pages 134–137.

5. Enter a Resolution value. The default resolution of 
240 ppi is assigned to all photos by Camera Raw. 

6. Optional: To apply predefined output sharpening 
to the photo for your output medium, from the 
Sharpen For menu, choose None, Screen, Glossy 
Paper, or Matte Paper. From the Amount menu, 
choose the desired level of sharpening (Standard 
is a good all-purpose choice). Note: The sharpen-
ing values that Camera Raw applies aren’t listed in 
any dialog. If you want to control the values when 
sharpening, set the Sharpen For menu to None 
and use the sliders in the Detail tab instead (see 
pages 70–71).

7. The Open in Photoshop as Smart Objects option 
converts the Open Image button in the Camera 
Raw dialog to an Open Object button, which 
opens the photo into Photoshop as a Smart 
Object. If you leave this option unchecked, you can 
convert Open Image to Open Object for any photo 
by holding down Shift. Learn about Smart Objects 
on pages 262–269.

8. Click OK. Your chosen workflow settings will be 
listed in the link below the preview and will be 
applied to the current photo and to all photos that 
you subsequently open into Camera Raw.

A Use the Workflow Options dialog to choose color space, bit depth, size, resolution, and sharpening 
settings  for the current — and future — photos.
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The Camera Raw tabs

To access a panel of related settings in Camera Raw, 
click one of the tab icons (shown above). We perform 
most of our work in the first four tabs, and recom-
mend that you do the same. Use the other tabs for 
specialty corrections or enhancements, as needed.

Basic: Adjust the white balance and exposure (see 
pages 63–67).

Tone Curve: Fine-tune a specific tonal range, such as 
the upper or lower midtones (see pages 68–69).

Detail: Apply capture sharpening and reduce 
unwanted noise (see pages 70–71).

HSL/Grayscale: Adjust the hue, saturation, and lumi-
nance of individual colors (see pages 72–73).

Split Toning: Apply one color tint to the highlight 
areas of a photo and a second tint to the shadow 
areas (see page 77).

Lens Corrections: Correct a photo for the effects of 
lens distortion, such as geometric distortion (e.g., a 
building that is tilted backward or isn’t level), under- 
or overexposure at the edges (an unwanted vignette), 
chromatic aberration, and color fringes.

Effects: As a special effect, apply a grain texture or a 
light or dark vignette (see pages 84–85).

Camera Calibration: The Process menu in this tab lets 
you update a file to the latest Camera Raw processing 
(see the sidebar on the next page). If the profile that 
Camera Raw provides for your camera model doesn’t 
produce satisfactory color results, use the sliders in 
this tab to tweak the settings manually.

Presets: Create a custom preset of the current Camera 
Raw settings for future application to any other 
photos (see page 93).

Snapshots: For flexibility in editing, save interim 
versions of a photo as you make corrections. When 

necessary, you can restore the photo to any snapshot 
version (see the sidebar on page 91).

If you find a need to undo or reset your slider settings 
as you work in Camera Raw, you can use any of the 
methods below. (To learn about related options on 
the Camera Raw Settings menu, see the next page.)

To restore default settings to sliders in 
the Camera Raw tabs:

 Do any of the following:

 Double-click a slider to reset it to its default value 
(usually 0).

 Shift-double-click a slider in the Basic tab to reset 
it to the Auto value.

 Click Default in the Basic or HSL/Grayscale tab to 
reset all the sliders in just that tab to 0.

 Hold down Alt/Option and click Reset at the 
bottom of the dialog (Cancel becomes Reset) to 
restore the settings, in all tabs, that were in effect 
when you opened the dialog.

Basic Detail Split Toning Effects

Tone Curve

Camera Calibration

HSL/Grayscale Presets Snapshots
Lens 

Corrections

Using the Camera Raw tabs

USING THE SCRUBBIES
To change a value quickly in a Camera Raw 
tab, instead of dragging a slider, drag to the 
left or right across the slider name (this is 
called a scrubby-slider).

TOGGLING THE PREVIEW
Check Preview at the top of the Camera Raw 
dialog (or press P) to preview changes made 
in all the tabs, or uncheck Preview to view the 
result of changes made in all the tabs except 
the current one, so you can compare the 
photo with and without the latest changes.
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When you open a photo into Camera Raw, by default, 
it’s adjusted according to the built-in profile for  
your camera model, and all the sliders in the Basic  
tab are set to 0. At any time, you can assign a differ-
ent collection of settings to your file, or restore the 
original settings. 

To restore settings via the Camera Raw 
Settings menu:

 From the Camera Raw Settings menu,  choose 
one of these options: A

 Image Settings to restore the settings that were 
attached to the file during the initial photo shoot 
or, if the photo was previously edited in Camera 
Raw, from the last Camera Raw session. When a 
photo is opened for the first time into Camera 
Raw, these settings will match the Camera Raw 
Defaults settings.

 Camera Raw Defaults to remove all custom set-
tings and reapply the default settings for your 
camera model, your specific camera, or the ISO 
setting that was used to take the photo.

 Previous Conversion to apply the settings from 
the prior image that was adjusted in Camera Raw.

 Custom Settings to reapply all the custom settings 
that you have chosen since opening Camera Raw.

 If a user-saved preset is applied to the current 
photo, that preset will also be listed as an option 
on this menu (see page 93).

UPDATING LEGACY PHOTOS AND THE CAMERA 
RAW SLIDERS
When you bring an unprocessed photo into Camera 
Raw 8.x, the dialog uses its most up-to-date profiles 
for noise reduction, de-mosaicing, sharpening, color 
calibration, and other processing. If you want to 
update a raw photo that was already processed in 
Camera Raw 6 or earlier using the new profiles, and 
also update the sliders in the Basic and other tabs to 
the newest versions (as described in this chapter), 
before applying any custom adjustments, click the 
Update to Current Process (2012)  icon at the bot-
tom right of the preview window. The Process menu 
in the Camera Calibration tab  changes to the set-
ting of 2012 (Current). Note: If you want to preserve 
access to the older rendering of the photo, take a 
snapshot of it before you update it (see the sidebar 
on page 91).

SETTING THE WHITE BALANCE
The color temperature of the lighting in which a 
photo is shot, whether natural or artificial, influences 
the relative amounts of red, green, and blue that are 
recorded by the camera. A digital camera attempts 
to balance the three colors to produce an accurate 
white, which in turn makes other colors in the photo 
more accurate; this is called the “white balance.” 

To fine-tune the white balance of a photo In 
Camera Raw, we recommend using the Temperature 
and Tint sliders in the Basic tab (see the next page). 
Another method — clicking with the White Balance 
tool  on an area of the photo that you want to 
become a neutral gray — should be used with care 
because finding exactly the right area to click is 
harder than it sounds.

A Use options on the Camera Raw Settings menu to restore 
default settings to your photo or to reapply the prior settings.
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C A Temperature value of 5500 strikes a good balance 
between warm and cool.

B We lowered the Temperature value too much. Now the 
photo looks too cool (has a bluish cast).

A When a photo is opened for the first time into Camera 
Raw, the White Balance menu in the Basic tab is set to As 
Shot. This photo has a high Temperature value and looks  
too warm (yellowish).

Using the Basic tab
As its name implies, the Basic tab contains the most 
essential correction features of Camera Raw — and it 
displays first, by default, when you open the dialog. 
We have divided the use of this tab into several tasks, 
beginning with setting the White Balance, on this page, 
then proceeding through exposure, contrast, and satu-
ration adjustments, on pages 64–67. 

To apply white balance adjustments via 
the Basic tab:

1. With a photo open in Camera Raw, click the Basic 
tab.  A If the whole photo isn’t visible in the pre-
view, double-click the Hand tool   in the toolbox.

2. Do either of the following:

 From the White Balance menu, choose a preset 
that best describes the lighting conditions in 
which the photo was taken, such as Daylight or 
Shade. (Choose As Shot, if needed, to restore the 
original camera settings. Note that only As Shot 
and Custom are available for JPEG and TIFF files.)

 Lower the Temperature value to add blue and 
make the image look cooler,B or raise it to add 
yellow and make the image look warmer.C To fine-
tune the temperature correction, move the Tint 
slider slightly to the left to add a bit of green or 
to the right to add magenta. (The White Balance 
menu setting changes to Custom, to indicate that 
you have chosen manual settings.)
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On the histogram in the Camera Raw dialog, the red, 
green, and blue areas represent the three color chan-
nels in a photo, and the white areas represent the 
areas where those three colors overlap. Clipping, the 
shifting of tonal values to absolute black or white in 
a photo, occurs if the tonal range of a scene is wider 
than the range that can be captured by the camera. 
You can tell that pixels are clipped in a photo if the 
vertical bars are primarily clustered in taller peaks at 
one or both ends of the histogram (shadow pixels on 
the left, highlight pixels on the right). 

As you make slider adjustments in Camera Raw, 
your goal is to bring the pixels into the range of your 
chosen RGB color space and minimize clipping. When 
tonal values are redistributed, the histogram updates 
accordingly. Note: Remember, we recommended that 
you choose Adobe RGB as the color space both for 
your camera (see page 6) and for Camera Raw (see 
page 60). 

To turn on the histogram clipping 
warnings for the preview:

 In the top left corner of the histogram, click the 
Shadow Clipping Warning button (U);A clipped 
shadows display in the preview as blue. In the top 
right corner, click the Highlight Clipping Warning 
button (O); clipped highlights display in the pre-
view as red. (When a button is activated, it has a 
white border.)

Use the middle batch of sliders in the Basic tab to 
apply tonal corrections to your photo, preferably in 
the order listed in the dialog (there’s a logic to their 
sequence). At first, all the sliders are set to 0 and the 
underlined word “Default” is dimmed. 

To apply exposure and contrast 
adjustments via the Basic tab:

1. Turn on the Clipping Warning buttons.

2. Use the Exposure slider to lighten or darken the 
entire photo, as needed.

3. Use the Contrast slider to increase or reduce the 
color intensity and tonal contrast (A–B, next page).

4. If you increased the contrast, the highlights and 
shadows probably now need to be adjusted:

 To restore details in the highlights, move the 
Highlights slider to the left until only a smidgen 
remains of the red highlight warning color.

Instructions continue on page 66

Shadow Clipping 
Warning button

Highlight Clipping 
Warning button

A Use the Clipping Warning buttons to let Camera Raw 
display the blue and/or red highlight colors over any 
clipped areas of your photo.
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B Our first goal is to lighten the overall photo and recover details in the midtones 
and shadows without washing out the highlights. In the Basic tab, we increased 
the Exposure value,* then increased the Contrast value to intensify the highlights, 
shadows, and color saturation. We’re not concerned that the photo is still too dark, 
as it can be lightened with further adjustments.

*We chose an Exposure value of +.60 for the raw version of this photo. If you are working with the JPEG version that we have 
supplied for downloading, use an Exposure value of +0.80 instead.

A This original photo was underexposed (too dark), causing the colors to look dull. The blue 
warning color in the preview indicates the shadow areas in the photo that are clipped. 
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A We reduced the Highlights 
value to recover details in the sky 
and increased the Shadows value 
to recover details in the shadows 
and lower midtones. The colors 
and detail in the midtones, and the 
overall balance of lights and darks, 
are improved. However, reducing 
the Highlights value caused the 
white areas to look dull.

 To restore details in the shadows, move the 
Shadows slider to the right until only a smidgen 
remains of the blue shadow warning color.A Or 
if you need to darken the shadows, move this 
slider to the left.

5. Now that details have been restored to the mid-
tones and highlights, you’re ready to adjust the 
whites and blacks:

 Increase the Whites value to brighten the white 
areas in the photo. This slider also has the effect 
of lightening the upper midtones and brighten-
ing the colors.

 Use the Blacks slider to lighten or darken the 
black areas (A, next page). This slider may also 
affect the color brightness.

 ➤ If the colors are now washed out as a result 
of your increasing the Whites or Blacks value, 
you could try increasing the Contrast value.

 ➤ To further adjust the tonal values in the 
midtones, see pages 68–69.

REMOVE CLIPPING IN THRESHOLD PREVIEW
To remove shadow clipping a different way, Alt-drag/ 
Option-drag the Shadows or Blacks slider. A Threshold 
preview displays (as shown below). Release the mouse 
when small amounts of color or black display in the 
white preview. 

You can also Alt-drag/Option-drag the Exposure, 
Highlights, or Whites slider to display a Threshold 
preview for that adjustment. Release the mouse when 
only a smidgen of white displays in the black preview.
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A We increased the Whites value 
to lighten the upper midtones  
and brighten the whites, and 
increased the Blacks value to 
recover more details in the shad-
ows. Overall, the brightness, as well 
as the colors, are much improved.

B Finally, we increased the Clarity 
value slightly to sharpen the 
details and increased the Vibrance 
value slightly to boost the color 
saturation (note the change 
on the car body). Our cumula-
tive adjustments to this photo 
improved the contrast, clarified 
the details, and produced richer 
color. Vroom, vroom!

To apply edge contrast and color saturation adjustments using the Basic tab:

1. To add depth by intensifying the edge contrast in 
the midtones, increase the Clarity value; or for a 
deliberate soft-focus effect (such as in a portrait or 
landscape), reduce the Clarity value.

2. Change the Vibrance value to adjust the color 
saturation.B

3. Turn off both clipping warnings by pressing U, 
then O. 

 ➤ We recommend using the Vibrance slider instead 
of the Saturation slider to adjust color saturation 
because the former is less likely to cause oversatu-
ration (and it protects skin tones), whereas the 
latter is more likely to cause oversaturation and 
highlight clipping. To view the effect of this, drag 
the Saturation slider to the far right.
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Using the Tone Curve tab 
After using the Basic tab, a next logical step is to 
make a more refined adjustment of the upper and 
lower midtones, which we recommend doing indi-
vidually via the Parametric sliders in the Tone Curve 
tab. (If you use Adobe Photoshop Lightroom, these 
Parametric controls will look familiar.)

Note: We avoid manipulating the curve in the 
nested Point tab, because a misshapen curve can 
cause a photo to look posterized. The sliders in the 
Parametric tab don’t cause this problem.

To apply tonal adjustments using the 
Parametric sliders in the Tone Curve tab:

1. With a photo open in Camera Raw,A click the 
Tone Curve tab,  then the nested Parametric 
tab. Behind the curve you’ll see a static display of 
the current histogram.

2. Do either of the following:

 If you have already adjusted the Highlights 
and Shadows sliders in the Basic tab, leave the 
Highlights or Shadows sliders in this tab alone 
and just tweak the upper and lower midtones 
using the Lights and Darks sliders. If you didn’t 
adjust the Highlights and Shadows sliders in the 
Basic tab, you can use the sliders here to lighten 
or darken any individual tonal range: Highlights, 

Lights (upper midtones), Darks (lower mid-
tones), or Shadows. As you move a slider, the 

corresponding portion of the curve will be 
raised above or lowered below the diagonal line 
(A–B, next page). 

 Click the Targeted Adjustment tool  (T). Drag 
within a tonal range of the photo that needs 
adjustment (C, next page). As you do this, the 
slider and curve that correspond to the tonal 
range under the pointer will move accordingly.

 ➤ To boost the contrast in a photo, try moving 
the Lights slider to the right and the Darks 
slider to the left. 

3. To control the range of tonal values that are 
affected by the slider adjustments you made in 
the preceding step, move any of the region con-
trols (located below the graph). The left region 
control affects the Shadows slider, the right 
region control affects the Highlights slider, and 
the middle region control affects both the Lights 
and Darks sliders (D–E, next page). Move a 
control to the left to raise the curve and lighten 
adjacent tonal ranges, or move a control to the 
right to lower the curve and darken adjacent 
tonal ranges. 

 ➤ To use one shortcut to get to the nested 
Parametric tab in the Tone Curve tab and 
select the Targeted Adjustment tool, press 
Ctrl-Alt-Shift-T/Cmd-Option-Shift-T.

A In this photo, the midtones are too dark — few details are visible in those areas.
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A To lighten the lower midtones, we 
increased the Darks value. This adjustment 
raised the middle of the curve.

D Finally, we moved the middle region 
control slightly to the right, which had 
the effect of increasing the contrast and 
lightening the sky. 

B More details are now visible in the lightened midtones, such as on the sides of the 
buildings and on the side and surface of the canal. However, the sky looks a bit dull.

E Now the tonal values in the image look just right.

C To lighten the upper mid-
tones (and thereby brighten 
the clouds, sky, and trees), we 
dragged upward over a light 
midtone area with the Targeted 
Adjustment tool;  the Lights 
value increased automatically. 
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All digital cameras produce some luminance (gray-
scale) noise and color artifacts (randomly colored 
pixels). Although budget cameras tend to produce 
the most noise, it can also be produced by a high-end 
camera if it’s used with a high ISO (light sensitivity) set-
ting in a poorly lit scene. It’s a good practice to remove 
as much noise from your photos as possible in Camera 
Raw, because it can become accentuated by image 
editing in Photoshop. 

As you follow these steps, you’ll discover that after 
you shift one slider, another one will need adjusting.

To reduce luminance and color noise 
using the Detail tab: 

1. With a photo open in Camera Raw (A, next page), 
click the Detail tab  and choose a zoom level of 
200–300% for the  preview.

2. To reduce grayscale noise (graininess), increase 
the Luminance value (B, next page). Try a value 
between 20 and 70.

3. Raising the Luminance value can cause high-
contrast edges in a photo to lose definition. To 
resharpen them, raise the Luminance Detail 
value — but not to the point that noise is reintro-
duced (C, next page). 

 ➤ To move a different area of the photo into 
view, hold down the Spacebar and drag.

4. Raise the Luminance Contrast value to restore 
some edge contrast. The effect of this slider is most 
noticeable in photos that contain a lot of noise.

5. Color artifacts and random speckling tend to be 
most noticeable in solid-color areas of a photo 
(e.g., flat surfaces), especially in shadow areas. 
To reduce these defects in a raw photo, increase 
the Color value to around 40–50, depending on 
the subject matter (for a JPEG photo, which has a 
default Color value of 0, use a lower Color value).

6. Raising the Color value may lower the intensity of 
colors in areas of the photo that were poorly lit. 
To restore some saturation and intensity to those 
areas, increase the Color Detail value from the 
default value of 50 to around 75, or until the color 
saturation looks good (D, next page). 

7. Lower the zoom level for the preview to judge the 
overall effect of the Detail settings.

 ➤ To reduce noise in select areas via the Adjustment 
Brush tool and a mask (see pages 74–76).

Using the Detail tab
Via the Sharpening sliders in the Detail tab, you can 
adjust the sharpness of your photo (a process called 
“capture” sharpening), and via the Noise Reduction 
sliders, you can reduce any unwanted color noise.

To sharpen a photo using the Detail tab:

1. Click the Detail tab  A and choose a zoom level 
of 100%. In the preview, drag to reveal an area of 
the photo that has some detail (hold down the 
Spacebar for a temporary Hand tool).

 Note: If the words “Sharpening (Preview Only)” 
display at the top of the Detail tab, click the Open 
Preferences button   in the toolbox. In the 
Camera Raw Preferences dialog, choose Apply 
Sharpening To: All Images, then click OK.

2. Under Sharpening, adjust the Amount value for 
the degree of edge definition. For subject matter 
that needs a lot of sharpening, such as hard-edged 
objects or buildings, try a value of 100; if less 
sharpening is needed, try a value of 50–60. (For a 
raw photo, the default Amount value is 25; for a 
JPEG photo, the default value is 0.)

 ➤ To better evaluate the Amount value via a 
grayscale preview, Alt-drag/Option-drag the 
slider.

3. Use the Radius slider to control how many pixels 
surrounding each edge are modified. We recom-
mend keeping this value between 1 and 1.3.

4. Alt-drag/Option-drag the Detail slider slightly to 
the right to sharpen edge details and textures.

5. Alt-drag/Option-drag the Masking slider to around 
50 to protect low-contrast areas with a black mask, 
and thereby sharpen only high-contrast areas.

A These are the Sharpening controls in the Detail tab.
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A This is a close-up of a photo of a 
shop window (viewed at a zoom level 
of 300%), with the Noise Reduction: 
Luminance and Color sliders in the 
Detail tab set to 0 (no noise reduction 
applied). Grayscale noise is evident 
in the signage, and color artifacts 
are evident on the poorly lit interior 
surfaces behind the letters. 

D To remove color artifacts from the dark areas, 
we increased the Color value to 40; this also had 
the effect of desaturating the colors. To revive the 
colors and produce the final version of the image 
(shown at left), we increased the Color Detail 
value to 60.

B To remove noise from the letters, we increased 
the Luminance value to 69, but this also dimin-
ished the edge definition.

C To resharpen the 
edges of the letters, we 
increased the Luminance 
Detail value to 65.
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Using the HSL/Grayscale tab
Using the powerful sliders in the HSL/Grayscale tab, 
you can adjust the hue, saturation, and luminance of 
each color component of a photo individually.

To adjust individual colors via the HSL 
sliders:

1. Click the HSL/Grayscale tab,  and double-
click the Hand tool  to fit the image in the 
preview.A

2. Click the nested Hue tab. Move any slider to 
shift that color into adjacent hues, as shown in 
the bar. For example, you could shift the Greens 

slider toward yellow to make a landscape look 
warmer, or toward aqua to make it look cooler. 

3. Click the Saturation tab. Move any slider to the 
left to desaturate that color (add gray to it) or to 
the right to make it more vivid (pure).B–C Avoid 
oversaturating the photo, to keep it looking real-
istic and so it stays printable. 

 ➤  To make a blue-ish sky more vivid, increase 
the saturation of the Blues and Aquas. To 
make a sunset look warmer, increase the 
saturation of the Oranges or Yellows.

A In the original photo, the sky lacks contrast and the reds on the car body 
are slightly undersaturated. 

C The Saturation adjustments intensified the reds in the car (particularly in 
the upper midtones) and intensified the blues in the sky.

B In the nested Saturation tab of the HSL/
Grayscale tab, we reduced the saturation of 
the Yellows and increased the saturation of the 
Reds and Blues.
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A In the nested Luminance tab, we lightened 
the Oranges and darkened the Reds, Yellows, 
Greens, and Blues. (Tip: Reducing the Blues 
value can make a photo look as if it was shot 
with a polarizing filter on the camera.)

B Decreasing the luminance of the Blues darkened the colors in the sky, 
while decreasing the luminance of the Reds and increasing the luminance of 
the Oranges produced a brighter, richer red on the car body. Now the colors 
are equally intense in the upper and lower areas of the photo.

USING THE TARGETED ADJUSTMENT TOOL
To apply local color adjustments to a photo, 
hold down Ctrl-Alt-Shift/Cmd-Option-Shift and 
press H, S, or L. The nested Hue, Saturation, 
or Luminance tab in the HSL/Grayscale tab 
displays and the Targeted Adjustment tool  
becomes selected. Drag upward or to the right 
over a color area to increase the slider values 
specifically for that area, or downward or to 
the left to decrease those values. The sliders 
that correspond to the color under the pointer 
will shift automatically.

4. Click the Luminance tab.A–B Move a slider to 
the left to darken that color (add black) or to the 
right to lighten it (add white). Avoid lightening 
any of the colors too much, to prevent the high-
lights from being clipped.

 ➤ For a more accurate rendering of your adjusted 
pixels, choose a zoom level of 66% or 100% for 
the Camera Raw preview.
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Using the Adjustment Brush tool 
Unlike corrections that are made in the Camera Raw 
tabs, which apply to the overall photo, corrections 
made with the Adjustment Brush tool are “local” (affect 
specific areas of the photo). You apply a mask in the 
preview to define which areas are going to be affected 
by the adjustment, then you apply the correction via 
the sliders. Use this tool after you have finished your 
broad, overall corrections, to fix a few specific areas or 
to accentuate some details.A Awesome feature!

To apply local edits with the Adjustment 
Brush tool:

1. After making adjustments in the Basic and Tone 
Curve tabs, click the Adjustment Brush tool  (K).  
The sliders for the tool display (some are like the 
sliders in the Basic tab).

2. Click the + or – button for any slider to “zero out” 
all the sliders except the one you click.

3. For the brush settings (the last four sliders), try a 
Feather value of 50–95 (to allow the edits to fade 
into surrounding areas), a Flow value of 60 (for the 
amount of adjustment produced by each stroke), 
and a Density value of 60 (for the level of transpar-
ency in the stroke).

4. Check Show Mask (Y) (scroll down in the settings 
area if you don’t see this option), adjust the brush 
size by pressing [ or ], then draw strokes over areas 
of the photo that need the same adjustment. A tint 
covers the areas where you apply strokes, and a pin 
appears where you started dragging.B

 ➤ The brush size is represented by the solid circle 
in the pointer; the feather value is represented 
by the black-and-white dashed circle.

5. Uncheck Show Mask, then use the sliders to apply 
adjustments to the masked areas (A, next page).

6. To apply different adjustment settings to other 
areas of the photo, click New, then repeat steps 2–5 
(B–E, next page, and A–C, page 76).

7. To redisplay the main tabs, press H (Hand tool).

 ➤ To show or hide all the pins, press V or check or 
uncheck Show Pins. To display the mask for an 
existing pin temporarily, with the mouse or your 
stylus, roll over the pin.

 ➤ To edit an adjustment, click a pin (a black dot 
appears in the center of the pin), then add to the 
mask and/or move the sliders. To remove areas of  
a mask, see page 76.

B We clicked the Adjustment Brush tool, zeroed out the 
sliders, checked Show Mask, then drew strokes on the face 
in the preview, avoiding the key facial features.

A We studied this photo and decided on what improve-
ments to make: Smooth the skin, sharpen the eyelashes, 
darken the eyebrows, and minimize the under-eye circles. 
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A We hid the mask, then chose a higher 
Tint value to add magenta to the skin tones, 
higher Exposure and Shadows values to 
lighten the skin tones, and lower Clarity and 
Sharpness values to smooth the skin texture. 
The results are shown at right.

B To sharpen 
the eyelashes, we 
clicked New, showed 
the mask, then 
covered the lashes 
using a small brush. 

C We hid the mask, then chose higher Contrast, Clarity, and 
Sharpness values to accentuate the masked areas, and a 
lower Exposure value to darken them.

D To darken 
the eyebrows, 
we clicked New, 
checked Show 
Mask, then masked 
those areas.

E We hid the mask, then chose a higher Contrast value to 
define the hairs more crisply against the skin, and lower 
Highlights and Shadows values for a darkening effect.
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B We hid the mask, then reduced the 
Temperature value to cool the redness of 
the skin tones; increased the Exposure, 
Highlights, and Shadows values to lighten 
the skin; and reduced the Clarity and 
Sharpness values to soften the skin texture.

USING THE AUTO MASK OPTION WITH 
THE ADJUSTMENT BRUSH TOOL
To mask an area according to color, zoom into 
that area. Check Auto Mask (M), position the 
Adjustment Brush tool over the color, scale 
the brush tip to cover just the width of the 
area, and start drawing a stroke. The mask will 
cover only the areas that match the first color 
area the brush touches. 

 ➤ If you want to change the mask overlay 
color, click the Mask Overlay Color swatch, 
then choose a color in the Color Picker.

C This final image shows the cumulative results of all the local 
corrections that we applied via the Adjustment Brush tool.

To remove Adjustment Brush tool edits:

1. With the Adjustment Brush tool  selected (K),  
check Show Mask (Y) and Show Pins (V).

2. Do either or both of the following:

 To remove adjustments locally, click a pin, click 
the Erase button (or hold down Alt/Option), then 
apply strokes where you want to erase the mask. 

 To remove a pin and its adjustments, click the pin, 
then press Backspace/Delete.

 ➤ To remove all Adjustment Brush tool edits and 
reset the mode to New, click the Clear All button.

A To minimize the 
dark circles under 
the eyes, we clicked 
New, checked Show 
Mask, then applied a 
mask to those areas. 
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Using the Split Toning tab
Using the Split Toning controls, you can apply one 
color tint, or tone, to the highlight areas of a photo 
and a different tint to the shadow areas. For the best 
results with this technique (and to mimic its traditional 
origins), convert the colors in your photo to grayscale 
first. We’ve gotten good results on photos of metallic 
objects, such as the antique car shown here.A

To apply a color tint to a grayscale version 
of a photo:

1. Click the HSL/Grayscale tab,  then check Convert 

to Grayscale. 

2. Click the Basic tab, and adjust the exposure and 
contrast.

3. Click the Split Toning tab. 

4. Move both of the Saturation sliders approximately 
halfway across the bar to make it easier to judge 
the colors you will apply in the next step (don’t 
worry that the photo looks awful).

5. Move the Highlights Hue slider to tint the high-
lights B and the Shadows Hue slider to tint the 
shadows.

6. Readjust the Saturation value for each hue.

7. Reduce the Balance setting to apply more of the 
Shadows tint to the entire photo, or increase it 
to apply more of the Highlights tint to the entire 
photo.C–D

A This is the original, full-color photo.

B After converting the colors in the photo to grayscale, we 
used the Split Toning tab to tint the highlights with a brownish 
yellow hue.

D This is the final result of our Split Toning adjustments. Applying 
separate tints to the highlights and shadows accentuated the lines and 
graceful curves of this sleek antique.

C Next, we tinted the shadows with blue, 
then moved the Balance slider to the right to 
favor the highlight color more. 
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Using the Lens Corrections tab
Via the Lens Corrections tab in Camera Raw, you can 
correct a photo for various adverse effects of lens dis-
tortion. You can straighten out an architectural feature, 
such as a building or fence, that looks as if it’s leaning 
toward or away from the viewer, or that is tilted hori-
zontally (isn’t level); and you can correct for under- or 
overexposure at the edges of a photo (vignetting). The 
corrections can be applied using a preset profile (this 
page) or manually (pages 79–81).

To correct geometric distortion and 
vignetting via Profile settings: ★
1. Click the Lens Corrections tab.  Double-click the 

Hand tool   to fit the image in the preview.

2. To access predefined lens profiles, click the Profile 
tab, then check Enable Lens Profile Corrections.

3. From the Setup menu,A do the following:

 Choose Auto to have Camera Raw read the EXIF 
metadata in the photo and attempt to select the 
proper lens make, model, and predefined profile. 

 If an error message indicates that the Auto option 
was unable to locate a profile, choose your lens 
manufacturer from the Make menu.B Camera Raw 
will locate a matching lens model and list it on the 

Model menu, and will locate a predefined profile 
and list it on the Profile menu. If the Model menu 
lists more than one model, choose the one with 
which the photo was shot.

4. Under Correction Amount, do the following:

 Set the Distortion value to control the amount  
of correction.

 Set the Vignetting value to correct for under- or 
overexposure at the edges of the photo.

5. Optional: If Camera Raw managed to locate your 
lens profile (step 3), you can save that profile and 
any custom Correction Amount settings as your 
new default profile by choosing Save New Lens 
Profile Defaults from the Setup menu. In future 
Camera Raw editing sessions, if you choose Default 
from the Setup menu, and the current photo was 
taken with this lens, the saved profile and settings 
will be applied. (To restore the Adobe predefined 
settings for your chosen lens, from the Setup 
menu, choose Reset Lens Profile Defaults.)

6. Optional: If you want to further correct any lens 
distortion manually, see the next task.

A Check Enable Lens Profile Corrections, 
then choose Auto from the Setup menu …

B … or choose your lens maker from the 
Make menu. Regardless of the Setup option, 
if necessary, adjust the Distortion value.
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To correct geometric distortion or vignetting via the Manual tab: ★
1. Click the Lens Corrections tab,  and double-click 

the Hand tool   to fit the image in the preview.A
2. Click the Manual tab.B
3. In the Upright area, click a button to apply a preset 

correction:

 Auto  to apply level correction and fix horizontal 
and vertical convergence, balanced with as little 
distortion as possible.C  

 Level  to apply only level correction (not fix hori-
zontal or vertical convergence).  

 Vertical  to apply level correction and fix vertical 
convergence (but not horizontal convergence).

 Full  for a stronger correction of horizontal and 
vertical convergence, in addition to level correction 
(A, next page).

4. If further manual correction is needed, do any of 
the following: 

 To spread the image out (fix pincushion distor-
tion), lower the Distortion value; or to pinch the 
image inward (fix barrel distortion), increase the 
Distortion value.

 ➤ To display a grid over the image so you 
can check the alignment, check Show 

Continued on the following page

A The original photo (above) shows signs of lens distortion: The house 
looks as if it’s tilting away from the camera, and it’s not level.

B We clicked the Manual tab (under Lens 
Corrections) to access these menu options 
and sliders.

C Under Upright, we clicked the Auto button for a balanced correction. This partially corrected the vertical lines 
and vertical tilt, but the left side of the house still looks as if it’s farther away from the viewer than the right side.
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A We clicked the Full button instead, which successfully made the house 
level and upright. To lighten the outer areas of the photo, we increased 
the Amount value (under Lens Vignetting).

Grid or press V. Adjust the grid size via the 
slider.B 

 To widen the top of the image, (correct key-
stoning) reduce the Vertical value; to widen the 
bottom of the image, increase the Vertical value. 
Readjust the Distortion value, if needed.

 To widen the left edge of the image, reduce the 
Horizontal value; to widen the right edge of the 
image, increase the Horizontal value.

 To rotate the image, change the Rotate value.

 To enlarge or shrink the photo, change the Scale 
value. Note: You could crop the photo instead.

 To stretch the image horizontally or vertically, 
change the Aspect value. This option is useful for 
correcting strong perspective distortion in photos 
taken with a wide-angle lens (A–B, next page).

 ➤ If you moved the Distortion slider, you can 
click Reanalyze (below the buttons) to force a 
recalculation of the Upright correction based 
on the Distortion value. If you want to turn 
off (but preserve) all your Upright corrections, 
click the Off button.  If you click a different 
Upright button, as an alert will inform you, all 
the Transform sliders (except Distortion) will 
be reset to 0.

5. To correct or apply Lens Vignetting (lighten or 
darken the outer areas of the photo), set the 
Amount value for the strength of the correc-
tion, then set the Midpoint value to expand the 
vignette inward or outward. Readjust the Amount 
value, if needed.

 ➤ To learn about the Lens Correction filter in 
Photoshop, see pages 332–333 and 439. 

B We made some minor 
Vertical and Rotate adjust-
ments, with Show Grid checked 
to help us gauge the effect.
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A We tried increasing the Aspect value, but 
this setting exaggerated and distorted the ver-
ticals of the house too much.

SYNCING LENS CORRECTIONS TO MULTIPLE PHOTOS ★
To apply Lens Corrections edits to multiple photos that you open into 
Camera Raw:

 ➤ If the photos don’t require 
exactly the same corrections, click 
one photo, choose settings in the 
Manual tab of Lens Corrections, 
then on the left side of the dia-
log, click Select All, then click 
Synchronize. In the dialog, choose 
Lens Corrections from the menu, 
check only Transform and Lens 
Vignetting, then click OK. Camera 
Raw will analyze and correct each 
photo separately (see also page 93). 

 ➤ If the photos do require exactly 
the same correction (e.g., brack-
eted shots of the same subject), 
click one photo, then click an 
Upright button in Lens Corrections. 
Click Select All on the left side of 
the dialog, then click Sync Results 
in Lens Corrections. The first photo 
will be analyzed according to the 
chosen Upright mode, then the 
same correction will be applied to 
all the other photos.

B Instead, we set the Aspect value to –5, which exaggerated the horizontal propor-
tion only slightly. The final settings we chose for the image are shown at right.
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Another use for the Lens Corrections tab is to correct 
for chromatic aberration (blue-yellow or red-green 
color shifts), as well as purple or green color fringes. 
These occur when a camera lens (especially one that 
is set to a wide aperture) doesn’t properly focus all the 
wavelengths of colored light precisely to the same spot.

To correct color shifts and/or fringes: ★
1. Click the Lens Corrections tab,  then click the 

Color tab. 

2. To remove any blue-yellow or red-green color 
shifts, check Remove Chromatic Aberration.A–B

3. Zoom to 100% view on an area where you suspect 
there is a purple or green color fringe, and with 
the Hand tool (H), center it in the preview. 

 Adjust the Purple Amount and/or Green Amount 
values. The higher the value, the wider the area 
on the edges of shapes in which fringe removal 
occurs. If the photo contains objects that are 
purple or green, beware of setting too high a cor-
rection value, which could degrade their color.

 ➤ To help you locate which areas of a photo 
contain purple or green fringes, zoom out, 
then Alt/Option click-and-hold on the Purple 
Amount or Green Amount slider. Areas where 
the fringe is present display as black.C–D 
Purple fringes commonly occur around specu-
lar highlights. Zoom back in when you're done.

 

C To preview any purple fringe as black, with  
Alt/Option held down, we clicked and held the Purple 
Amount slider. Black displayed along the edge of the 
stone semicircle.

D To preview any green fringe as black, with Alt/
Option held down, we clicked and held the Green 
Amount slider. No black displayed, a sign that green 
fringe wasn’t an issue in this area of the photo.

A We noticed a purple fringe along the edge of the stone semicircle in this photo.

B To remove any blue-yellow and red-green 
color shifts, we checked Remove Chromatic 
Aberration. 
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C Compare this original image to the final image, which is 
shown at right.

D The purple fringe is gone from the edge of the semicircle. 

 To control the range of hues that the Purple 
Amount and Green Amount sliders affect (in other 
words, the area in which fringe removal occurs), 
drag the Purple Hue or Green Hue bar over a hue 
area on the spectrum (the spectrum of affected 
colors displays within the bar) and/or widen or 
narrow the range by dragging either endpoint of 
the bar. (To reset the bar to its default length and 
position, double-click within it.)

 ➤ To display the affected colors temporarily as 
black in the preview, zoom out a bit, then with 
Alt/Option held down, drag the Purple Hue or 
Green Hue bar.A–D

 ➤ When adjusting a photo that contains foliage, 
avoid positioning the Green Hue bar over the 
orange/yellow color range (at the left end of the 
spectrum), which could gray out the essential 
yellows in the image.

A We increased the Purple Amount value, then held down Alt/
Option and dragged the Purple Hue bar slightly to the left. At 
this setting, the fringe correction was affecting the top of the 
stone semicircle — which wasn’t our intention.

B We held down Alt/Option and dragged the Purple Hue bar 
to the right, then dragged the right endpoint inward to nar-
row the range. At this setting, the fringe correction is affecting 
primarily the edge of the semicircle — mission accomplished.
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Using the Effects tab
In traditional photography, the faster the film speed, the 
larger and more apparent the grain. As an intentional 
effect, you can simulate this grainy texture via the Grain 
controls in Camera Raw. Choose a photo that won’t 
suffer aesthetically when its details lose definition.

To add a grain texture to a photo: 

1. Click the Effects tab,  and double-click the Hand 
tool   to fit the image in the preview.A

2. To create a noticeable grain, under Grain, choose an 
Amount value of around 50.

3. To emulate the fine grain of slow film or the coarse 
grain of fast film, do as follows:

 Set the Size value for the size of the grain particles.B 
When this value is greater than 25, a small degree of 
blurring is also applied, to help blend the grain with 
the imagery.

 Reduce the Roughness value below the default 
value of 50 for a more uniform grain, or increase it 
for an uneven, coarse grain.C Zoom in to examine 
the grain, then readjust the Amount value, if needed.

C We increased the Amount to 75, the Size to 60, and the 
Roughness to 65. The coarser grain unifies the highlights and 
background with the food textures even more. Please pass 
the Parmesan…

B The first settings we chose were Grain Amount 50 and 
Size 80 (we left the Roughness control at the default value of 
50). The food textures are beginning to blend with the soft 
background. 

A This photo is a good candidate for the Grain effect 
because we won’t mind if the details are softened and 
it contains muted colors.
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Using the Post Crop Vignetting controls, you can apply a 
light or dark vignette to a photo (lighten or darken the  
outer areas). If you crop the photo subsequently in Camera 
Raw, the vignette will reconform to the new dimensions.

To apply a vignette to a photo: 

1. Click the Effects tab,  and double-click the Hand 
tool   to fit the image in the preview.A

2. Under Post Crop Vignetting, do all of the 
following: B–D

 Choose Style: Highlight Priority.

 Choose a negative Amount value for a dark vignette 
or a positive value for a light vignette.

 Adjust the Midpoint value to expand the vignette 
inward or outward.

 Adjust the Roundness value to make the vignette 
shape more oval or more like a rounded rectangle.

 Adjust the Feather setting to control the softness  
of the transition to the nonvignetted areas.

 Adjust the Highlights setting to control the bright-
ness of the highlights within the vignette area.

A This is the original image.

C We lowered the Midpoint value and 
raised the Feather and Highlights values.

D When we cropped the image, the 
vignette readjusted automatically. 

B In the Effects tab, under Post Crop 
Vignetting, we chose the values above.
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Using the Graduated Filter tool
When shooting landscapes, you may have run into 
this common predicament: You set the proper expo-
sure for the foreground, and the sky winds up being 
overexposed. To solve this problem on site, you can 
reduce the light on the upper part of the lens with a 
graduated neutral-density filter. To darken a sky in  
a photo that is shot without such a filter (Plan B!), you 
can use the Graduated Filter tool in Camera Raw. 

With this tool, you create an overlay to define the 
area to be edited, then you apply the adjustment via 
any of a dozen sliders. The slider options are the same 
as for the Adjustment Brush tool.

To adjust an area of a photo using the 
Graduated Filter tool:

1. After adjusting your photo via the Basic and Tone 
Curve tabs,A choose the Graduated Filter tool  
(G). The sliders for the tool display in the right 
panel.

2. Click the + or – button for any slider to “zero out” 
all the sliders except the one you click.

3. Shift-drag over an area in the photo to define the 
area where the filter edits will be applied, begin-
ning from the location where you want the stron-
gest adjustment. The filter will be applied fully at 

the green dashed border of the overlay, gradually 
diminishing to nil at the red dashed border.

4. Do either or both of the following:

 Use the Temperature and/or Tint slider to make 
the filtered area warmer or cooler.

 Use the sliders to adjust such characteristics as 
the exposure, sharpness, or noise in the filtered 
area (A–C, next page).

5. To redisplay the main tabs, press H (for the Hand 
tool).

 ➤ At any time, you can lengthen or shorten the filter 
overlay by Shift-dragging the green or red dot. To 
reposition the whole overlay, drag the line that 
connects the two dots. 

 ➤ To apply a separate filter to another area of the 
photo, click New, then repeat steps 2–4.

 ➤ If you want to draw an overlay on a diagonal, 
don’t hold down Shift while dragging.

 ➤ To hide the filter overlay, uncheck Show Overlay 
or press V. To remove a filter overlay, click one of 
its dots or the line that connects them, then press 
Backspace/Delete.

A Despite our applying Basic and Tone Curve adjustments, the sky in this photo looks over-
exposed (washed out).
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C In the final image, the adjustment is strongest in the sky, fading to nil in the upper part 
of the ground.

A After zeroing out the sliders for the Graduated Filter tool, we Shift-dragged 
downward in the photo (as shown by the arrow above), then chose slider settings 
to darken the exposure within the overlay area. 

B To add more blue to the upper area of 
sky, we lowered the Temperature value.
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Using the Radial Filter tool
With the Radial Filter tool, you define an elliptical area 
with an overlay, then apply adjustments via sliders to 
the area either inside or outside the overlay.

To darken an area of a photo via the 
Radial Filter tool: ★
1. After adjusting your photo via the Basic and Tone 

Curve tabs,A click the Radial Filter tool  (J). The 
sliders for the tool display.

2. Click the + or – button for any slider to “zero out” 
all the sliders except the one you click. At the 
bottom of the panel, click Effect: Outside or Inside 
to control where the filter effect will occur relative 
to the overlay you will draw in the next step.

3. Drag over an area in the photo to produce an 
overlay.B If you want to reposition the overlay as 
you create it, drag with the Spacebar held down. 

4. Use any of the sliders to adjust the filtered area 
(A–C, next page). If the Effect setting is Outside, 
the adjustment will be at full strength outside the 
overlay, then diminish gradually to no adjustment 
at the dashed border. If the Effect setting is Inside, 
the adjustment will be at full strength at the 
center of the overlay and diminish gradually to  
no adjustment at the dashed border.

A Although the exposure in this photo is well bal-
anced, we want to spotlight the spa products more.

B We zeroed out the sliders for the Radial Filter tool, then dragged in the preview to create an overlay.
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5. To control how gradual the adjustment is at the 
edge of the overlay, use the Feather slider.

6. To hide the overlay(s) to gauge the adjustment, 
uncheck Show Overlay or press V. Redisplay the 
overlay for the next step.

7. To edit the overlay, do any of the following (all 
optional):

 To reposition the overlay, drag inside it. 

 To reshape the overlay, drag one of the handles.

 To resize the overlay, Shift-drag a handle. 

 To swap the adjustment from Outside to Inside 
the overlay, or vice versa, click the unselected 
Effect button or press X. 

8. Optional: To add another overlay, click New, then 
follow steps 2–7. Be aware that the adjustment 
will be cumulative where the overlays overlap. 
When there are multiple overlays, you need to 
click the pin of the one you want to edit. To delete 
a selected overlay, press Backspace/Delete.

9. To redisplay the main tabs, press H (Hand tool).

 ➤ To expand an overlay to the edges of a photo, 
double-click inside it. To produce a new overlay 
that does the same thing, double-click in the 
preview. 

A We used the first four sliders to darken the filtered 
area and the Clarity and Sharpness sliders to soften the 
image details.

B To make the lighting in the darkened 
areas cooler, we reduced the Temperature 
value (added blue).

C The tonal, temperature, and sharpness adjust-
ments help to accentuate the candle, soap, and 
white bottle.
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Using the Spot Removal tool
Use the Spot Removal tool to remove small imperfec-
tions, such as spots caused by dust on the camera lens, 
blemishes in a portrait, or insects on flowers. Camera 
Raw locates a source area for the repair automatically, 
but you can also have some input.

To remove blemishes or spots: ★
1. Choose the Spot Removal tool  (B).

2.  Zoom in on an area to be repaired.

3. Press [ or ] to size the brush cursor, then do one of 
the following: 

 Ctrl-Alt-drag/Cmd-Option-drag outward from the 
center of a blemish to create and scale a target 
circle A; or click a blemish; or if you want to con-
trol which area Camera Raw uses as the source, 
Cmd-drag/Ctrl-drag from the target area to the 
desired source area. When you release the mouse, a 
red dashed circle surrounds the target region and 
a green dashed circle surrounds a source area.B

 Drag across a blemish to create a target region.  
When you release the mouse, a red pin and 
dashed border surrounds the target region and a 
green pin and dashed border surrounds a source 
region.C–D

 ➤ To display a black-and-white version of the 
photo to help you pinpoint dust spots or other 
irregularities, check Visualize Spots (Y). Adjust 
the black-to-white threshold via the slider.

4.  From the Type menu, choose Heal to blend source 
pixels into the texture and luminosity values of the 
target pixels (usually the best choice) or Clone to 
copy the source pixels exactly without any healing. 

 Optional: To cycle through alternative source 
locations that Camera Raw detects, press /.

5. Select a target or source region by clicking its pin 
or select a circle by clicking inside it, then do any 
of the following optional steps:

 To reposition a region or circle, drag inside it.

 To control the opacity of the repair, use the 
Opacity slider.

 To resize a pair of target and source circles (not 
irregular-shaped regions), drag the dashed border.

 To add to an existing region (or to convert a circle 
to a region), Shift-click or Shift-drag just outside it.

6. Optional: Create more regions or circles to correct 
other blemishes. To remove a pin or circle, hold 
down Alt/Option and click it; or to delete multiple 
pins and circles, Alt/Option drag a marquee across 
them. (To remove all pins and circles, click Clear All.)

7. To hide all regions and circles, uncheck Show 

Overlay (V). 

8. To redisplay the main tabs, press H (Hand tool).

 ➤ To redisplay the Spot Removal overlays at any 
time, choose the tool again (press B).

A With the Spot 
Removal tool, we held 
down Ctrl-Alt/Cmd-
Option and dragged 
to create a target circle 
around a blemish.

B The tool created a linked source circle 
in a similar area and repaired the blemish. 

C Here we’re drag-
ging to create a 
target region.

D The tool created a source region 
and two pins.
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Saving and applying Camera Raw 
settings
After carefully choosing custom settings for a photo in 
Camera Raw, you’ll be glad to know that you can save 
those settings as a preset and then apply the preset to 
other photos that need the same or similar corrections. 

To save Camera Raw settings as a preset: 

Method 1 (Camera Raw Settings menu)

1. With your corrected photo open in Camera Raw, 
choose Save Settings from the Camera Raw 
Settings menu.  

2. The Save Settings dialog opens.A Check the cat-
egories of settings you want saved in the preset. 
Or to filter the number of checked boxes, choose a 
category (tab name) from the Subset menu, then 
recheck any boxes, if desired.

3. Click Save. A different Save Settings dialog opens 
(yes, it’s confusing that the two dialogs have the 
same name). Enter a name (preferably one that 
describes the function of the preset), keep the 
location as the Settings folder, then click Save.

4. The saved settings preset is now available in the 
Presets tab  for any open photo.

Method 2 (Presets tab)

1. With your corrected photo open in Camera Raw, 
click the Presets tab,  then click the New Preset 
button.  

2. In the New Preset dialog, enter a name for the 
preset. Check the settings you want saved in the 
preset, or choose a category (tab name) from the 
Subset menu, then recheck any boxes, if desired. 
Click OK. Your new preset is now available in  
the Presets tab for any open photo.

 ➤ To delete a user-saved preset, click the preset 
name, then click the Delete button.  

You can apply a user-defined preset (saved collec-
tion of settings) to a single photo via Camera Raw 
(see below), to multiple photos via Bridge (see the 
following page), or to multiple thumbnails via the 
Synchronize option in Camera Raw (see page 93).

To apply a Camera Raw preset to a photo: 

 With a photo open in Camera Raw, click the 
Presets tab,  then click a preset name.

 ➤ You can also apply a preset via the Apply Preset 
submenu on the Camera Raw Settings menu.

A In the Save Settings dialog, check which of your 
custom Camera Raw settings are to be saved in a preset.

TAKING SNAPSHOTS OF YOUR CR SETTINGS
A snapshot is a record of the current Camera Raw 
settings that you have chosen for a photo. By saving 
snapshots of your photo periodically while editing 
it, you preserve the option to restore the photo 
to those earlier settings. Unlike snapshots on the 
History panel in Photoshop, snapshots save with 
the Camera Raw file. Click the Snapshots tab,  
then click the New Snapshot button.   In the New 
Snapshot dialog, enter a name, then click OK. To 
restore the photo to a snapshot at any time, click a 
snapshot name in the Snapshots tab. (For other ways 
to restore Camera Raw settings, see pages 61–62.) 

 ➤ To update an existing snapshot with the current 
settings, right-click the snapshot listing and choose 
Update with Current Settings from the context menu.
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The settings presets that you save in the Presets tab of 
the Camera Raw dialog can also be applied to multiple 
photos via the Develop Settings submenu in Bridge. 
In fact, as a strategy, you could save separate presets 
for settings in individual Camera Raw tabs and then 
assign them to multiple photos in succession (e.g., a 
preset for the Basic tab first, then a preset for the Tone 
Curve tab, and so on). If you haven’t saved the needed 
settings as presets, a quick alternative method is to 
copy and paste all the current settings from one photo 
into one or more other photos.

To apply Camera Raw settings to multiple 
photos via Bridge: 

Method 1 (apply a preset)

1. In Bridge, Ctrl-click/Cmd-click multiple photo 
thumbnails (or Shift, then Shift-click a consecutive 
series of thumbnails).

2. To apply settings, from the Edit > Develop 

Settings submenu, choose a preset; or right-click 
a selected thumbnail and choose a preset from 
the Develop Settings submenu on the context 
menu.A Choose additional presets, if needed.

Method 2 (copy and paste settings from a photo)

1. Click the thumbnail for a photo that has the 
desired settings, then choose Edit > Develop 
Settings > Copy Camera Raw Settings (Ctrl-Alt-C/
Cmd-Option-C), or right-click the selected thumb-
nail and choose Develop Settings > Copy Settings  
from the context menu.

2. Click another thumbnail (or Ctrl-click/Cmd-click 
multiple thumbnails), then choose Edit > Develop 
Settings > Paste Camera Raw Settings (Ctrl-Alt-V/
Cmd-Option-V), or right-click the selected thumb-
nail and choose Develop Settings > Paste Settings 
from the context menu.

3. The Paste Camera Raw Settings dialog opens. 
Uncheck any settings you don’t want to paste; or 
choose a tab name from the Subset menu, then 
remove or add any check marks. Click OK.

 ➤ To remove all Camera Raw settings from a selected 
photo thumbnail in Bridge, choose Edit > Develop 
Settings > Clear Settings or right-click the thumb-
nail and choose Develop Settings > Clear Settings 
from the context menu. 

A Using commands on the Develop Settings submenu in Bridge, you can apply one or more saved settings presets to multiple 
selected thumbnails, or copy and paste the current settings from one thumbnail to other thumbnails.
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Synchronizing Camera Raw 
settings
When you open multiple photos into Camera Raw, 
they are represented by thumbnails in a panel on the 
left side of the dialog. After adjusting one photo, you 
can click Synchronize to apply those settings to one 
or more of the other photos. Because it’s unlikely that 
every single adjustment needed for one photo will be 
perfectly suited to all the others (even photos taken 
during the same shoot), a more practical approach is to 
adjust subsets of the grouping. For instance, you could 
apply a settings preset or some Basic tab adjustments 
to one photo (say, to correct the white balance and 
exposure), apply those settings to most or all of the 
other photos, then select incrementally smaller num-
bers of photos and apply more targeted or specialty 
adjustments.

To synchronize the Camera Raw settings 
among multiple photos:

1. In Bridge, select two or more photo thumbnails, 
preferably ones that were shot under the same 
lighting conditions and that require the same kind 
of correction (for the most accurate and consistent 
corrections, select all raw files or all JPEG files). 
Double-click one of the selected thumbnails.

2. In the filmstrip panel on the left side of the Camera 
Raw dialog, click one of the thumbnails.A 

3. Make the needed adjustments to the selected 
image (including cropping, if you want to crop all 
the images in exactly the same way). You can apply 
adjustments via the tabs or tools or by clicking a 
preset in the Presets tab.  

4. Click Select All at the top of the filmstrip panel or 
Ctrl-click/Cmd-click the thumbnails to which you 
want to apply corrections, then click Synchronize. 

5. The Synchronize dialog opens (it looks like the 
Save Settings dialog, which is shown on page 91).
Check only the settings you want to apply to all 
the selected thumbnails; or choose a category 
from the Synchronize menu, then remove or add 
any check marks. Click OK.

 ➤ To cycle through the photos in the filmstrip panel, 
click the left or right arrowhead below the preview 
(in the lower right). If more than one thumbnail is 
selected, Camera Raw will cycle among only those 
photos.

A We opened four photos into Camera Raw. The thumbnails 
for the images display in the filmstrip panel on the left side of 
the dialog.

WHERE CR SETTINGS ARE SAVED
Depending on the setting on the Save Image Settings 
In menu in the Camera Raw Preferences dialog 
(Ctrl-K/Cmd-K), settings for raw photos (not JPEGs) 
are saved either in the internal Camera Raw Database 
on your system or as hidden Sidecar .xmp Files in the 
same folder as the raw files. Don’t confuse these files 
with user settings files that you create via the Save 
Settings command.
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Converting, opening, and saving Camera Raw files
Still with us? At long last, you get to open your 
Camera Raw file into Photoshop.

To open a photo from Camera Raw into 
Photoshop:

1. After applying adjustments to your photo in 
Camera Raw, click Open Image; or if you opened 
and corrected multiple files, select them on the 
left side of the dialog, then click Open Images. 

2. The photo appears as the Background in a new 
Photoshop document (or documents). Save the 
file(s) in the Photoshop (PSD) format. 

 Note: If Open in Photoshop as Smart Objects is 
checked in the Workflow Options dialog (see 
page 60), the Open Image button is labeled Open 
Object and a photo opens as a Smart Object in 
a new Photoshop document. To learn about the 
advantages of using Smart Objects, see pages 
262 and 265. To edit the Camera Raw settings 
of a Smart Object, see page 266. If the workflow 
option is off, you can convert the Open Image 
button to Open Object by holding down Shift.

 ➤ To close the Camera Raw dialog without open-
ing your file, but save your settings to the file as 
instructions, click Done. The settings will redisplay 
if you reopen the file in Camera Raw.

If desired, you can open a copy of a Camera Raw file with 
its current (custom) settings into Photoshop without 
changing the settings in the original raw or JPEG file.

To open a copy of a camera raw file:

 In the Camera Raw dialog, hold down Alt/Option 
and click Open Copy (Open Image or Open 
Object becomes Open Copy).

Via the Save Options dialog in Camera Raw, you can 
convert and save a copy of a photo in the Digital 
Negative (DNG), JPEG, TIFF, or Photoshop (PSD) format. 

When you save a copy of a photo in the DNG 
format via the Save Options dialog, the Camera Raw 
settings it adopts from the original file remain acces-
sible and editable in Camera Raw. See also the sidebar 
on this page.

When you save a photo in the JPEG, TIFF, or PSD 
format via this dialog, the Camera Raw settings are 
applied to the copy permanently. Although you 
can open and edit the resulting JPEG or TIFF file 
in Camera Raw, you will see that the sliders are reset 
to their default values. PSD files can’t be opened in 
Camera Raw.

To save a copy of a Camera Raw file in the 
DNG, JPEG, TIFF, or PSD format:

1. Open and adjust a photo in Camera Raw.

2. In the lower-left corner of the dialog, click Save 

Image. The Save Options dialog opens. 

3. For the Destination, choose Save in Same 

Location or Save in New Location. For the latter, 
choose a location in the Select Destination Folder 
dialog, then click Select. 

4. In the File Naming area, choose a naming or num-
bering convention from the menu or enter a file 
name. If desired, you can also choose a naming or 
numbering convention from the adjacent menu. 

5. Choose a Format: Digital Negative, JPEG, TIFF, or 
Photoshop, then choose format-related options. 
For instance, if you cropped the photo in Camera 
Raw and choose the Photoshop format here, you 
will need to decide whether to check Preserve 
Cropped Pixels.

6. Click Save. A copy of the file appears in the desig-
nated location. The original file remains open in 
Camera Raw, with its current settings.

ARCHIVING PHOTOS AS DNG FILES
Photographs capture unrepeatable moments, and 
archiving them is both a priority and a concern for 
photographers. Ideally, there would be one standard 
file format for digital photos that photographers 
could depend on with confidence, knowing their 
photos will be stable and accessible for the foresee-
able future. At the present time, each camera maker 
uses a unique, proprietary format for their raw files. 
Should a maker discontinue its format, raw photos 
from their cameras might become unreadable by 
Photoshop or other image-editing applications.

Luckily, DNG (short for Digital Negative), a format 
developed by Adobe, preserves all the raw, unpro-
cessed pixel information that is recorded by the 
camera. The coding for the DNG format is nonpropri-
etary (open standard), meaning that it is accessible to 
all interested companies. DNG may be the long-term 
solution that photographers will eventually come to 
rely on — provided it is adopted as the standard by a 
majority of camera and software manufacturers.
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A
Action Options dialog, 426
actions

command insertion, 432
command modal controls, 433
command settings, changing, 436
conditional steps, adding, 434–435
defined, 114, 425
deleting, 436
droplets for, 430
duplicating, 431
edit insertion, 432
edit order, 436
editing, 431–436
excluding command from  

playback, 427
menu item insertion, 432
modal controls, 433
partial, playing, 427
playback options, 427
playing on batch of images, 428–429
playing on one image, 427
recording, 425–426
renaming, 431
rerecording, 433
ruler units in, 426
sets, 436
Stops, inserting, 431
testing, 435
use suggestions, 429

Actions panel

Button mode, 427
Dialog icon, 433
illustrated, 114, 425
Insert Conditional command, 434
Insert Menu Item command, 432
Insert Stop command, 431
List mode, 425, 427
loading set onto, 436
New Action button, 426, 431, 434
Play button, 427
Playback Options command, 427
Record Again command, 433
Reset Actions option, 436
Save Actions command, 436
uses, 425

Add Anchor tool, 113
Adjustment Brush tool (Camera Raw)

Auto Mask option, 76
defined, 57

edits, removing, 76
local edits with, 74
using, 74–76

adjustment layer presets

choosing, 216
deleting, 220
saving, 220

adjustment layers

applying to video clips or tracks, 456
Black & White, 240–248
Brightness/Contrast, 226
clipping, 219, 268
Color Balance, 230–231, 331
creating, 124, 216–217
Curves, 229, 236–239
defined, 122
deleting, 220
editing, 124
effects, hiding, 218
filters and, 367, 368
Gradient Map, 242–243
Hue/Saturation, 232
identifying, 217
layer effects application to, 387
Levels, 224–225, 252
mask, editing, 221
merging, 162, 220
new edits, viewing images  

without, 218
options on Properties panel, 124
Photo Filter, 227
presets, 220
settings, editing, 218
settings, restoring, 218
Vibrance, 233–235

Adjustments panel

Auto-Select Parameter option, 219
Black & White button, 240
Brightness/Contrast button, 226, 438
buttons, 115, 216
Color Balance button, 230
Curves button, 229, 236
Gradient Map button, 242
Hue/Saturation button, 232, 306
illustrated, 115
Levels button, 224, 229, 252, 387
Photo Filter button, 227
Reset to Adjustment Defaults  

button, 218
Vibrance button, 233, 234, 235

View Previous State button, 218
Adobe Bridge. See Bridge
Adobe Creative Cloud, 497-499
Adobe Exchange panel, 115
Adobe Illustrator. See Illustrator, Adobe
Adobe InDesign. See InDesign, Adobe
Adobe RGB color space, 5–6
Advanced preferences (Bridge), 474
Airbrush tips, 290
alert dialogs

resetting all, 461
upon opening files, 35

aligning

images (Camera Raw), 79
layers, with Auto-Align Layers 

command, 280–281
layers, with one another, 275
point type, 374
shapes in same layer, 412
with Smart Guides, 155
type, 382
vector objects, 408

alpha channels

deleting, 178
editing, 178
layers while recording actions, 426
loading as selection, 178
saving selections as, 178, 184
thumbnails, 331

ANPA colors, 201
anti-aliasing

selection tools and, 173
type tools and, 374

Application frame

defined, 95
docking document windows into, 97
illustrated, 95, 96
Mac OS, 96
minimizing, 96
redocking floating panels into, 105

archiving files in the Creative Cloud, 
498–499

Art History tool, 113
artistic borders, 440–441
Assign Profile dialog, 12
audio clips, 458
Auto Color Correction Options  

dialog, 228–229
Auto Resolution dialog, 136
Auto-Align Layers dialog, 280–281

Unless noted otherwise, the listings in this index pertain to Photoshop.



502  Index

B
Background

converting into layer, 150
converting layer to, 150
deleting selection from, 168
duplicating, 294
filling selection on, 168
moving upward on list, 152
new document, choosing for, 15
shade around canvas area, 102

Background color

choosing, 199–204
filters that use, 360

Background Eraser tool, 113
baseline shift, 381
Basic tab (Camera Raw)

Clipping Warning buttons, 64
color saturation adjustments, 67
contrast adjustments, 64–66
defined, 61, 63
edge contrast adjustments, 67
exposure adjustments, 64–66, 

270–271
using, 63–67
white balance adjustments, 63

Batch dialog, 428–429
Batch Rename dialog (Bridge), 44
Behance, 500
Bevel effect, 394–395
bit depth

changing, 362
photoshop channels and, 2

Bitmap mode, 4
Black & White adjustment layer

grayscale conversion via, 240–248
Targeted Adjustment tool, 240
tints, 240, 242

blemishes, removing 
Spot Healing Brush tool, 311
Spot Removal tool (Camera Raw), 90

blending layers

Blending Options, 346–347
modified with original one, 344
opacity, 345

blending modes

brush, 286
categories, 205
choosing, 205–206
cycling through, 206
fill layer, 207–209
filters and, 368

Blending Options

for Layers, 346–347
for Smart Filters, 363

blur filters

Field Blur filter, 326, 327, 331
Iris Blur filter, 326, 328, 331
Lens Blur filter, 323–325
Lens Correction filter, 332–333
Motion Blur filter, 334–335
selections with, 327
Sharpen tool, 335
Smart Sharpen filter, 336–338
Tilt-Shift filter, 326, 329, 331
Unsharp Mask filter, 339–340

Blur Gallery filters, 326–331
Blur tool, 113
bokeh options in Blur Gallery, 330
Bridge

cache, exporting, 50
collections, 46–47
Collections panel, 26, 46–47
Content panel, 26, 30, 32, 34, 37
Favorites panel, 26, 30, 45
file management, 43
file searches, 45
Filter Items By Rating menu, 41
Filter panel, 26
Folders panel, 26, 30
image previews in, 30–33
keywords, 38–39
Keywords panel, 26, 38–39
launching, 23
loupe

preference settings for, 472
using, 32

metadata display, 37
Metadata panel, 26, 39
Metadata placard, 30
Mini Bridge, 48–49
navigation controls, 30
opening files from, 34–35
Options for Thumbnail Quality and 

Preview Generation menu, 31
panes and panels, customizing, 36
Photo Downloader, 24–25
Preview panel, 26, 30
Refine menu, 33
Review mode, 33, 40
thumbnails, 30, 31, 32, 36, 40–43
uses, 23
View Content buttons, 37
window customization, 36–37

window features, 26–27
window illustration, 27
workspaces

choosing, 28–29
custom, 38
default, 26
deleting, 38
resetting, 38
saving, 38

Brightness/Contrast adjustments, 226
bristle brushes, 292–293
Brush panel

Airbrush tips, 290
Angle option, 287
Brush Pose option, 292
Brush Projection option, 288
Brush Tip Shape option, 286, 289, 290
Color Dynamics option, 288
Create New Brush button, 289
customizing brushes via, 286–289
displaying, 115
Erodible Point tips, 289–290
Hardness option, 287
illustrated, 115, 287
Live Brush Tip Preview button, 289
New Brush button, 128
quick access to, 291
Roundness option, 287
Scattering options, 288
Shape Dynamics option, 287
Size option, 286
Spacing option, 287
Texture option, 288
Transfer option, 289
uses, 115

Brush Preset picker, 285, 304–305
brush presets

deleting, 291
identifying types of, 126
loading, 291
managing, 291
names, viewing, 295
resetting, 291
saving, 129, 131, 291
tools that use, 126

Brush Presets panel

illustrated, 116
Live Brush Tip Preview button, 289
quick access to, 291
saving brushes from, 129
using, 291

brush strokes, recording, 426
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Brush tool

Airbrush tip, 290
choosing settings for, 126–127
creating selections with, 185
defined, 112
dodging and burning areas with, 247
Erodible tip, 289–290
in hiding filter effect, 364
Options bar, 184, 187, 221, 247, 286
painting with, 285–290
reshaping layer masks with, 187, 274
reshaping selections with, 184
in turning photos into drawings, 372

brushes

blending mode, 286
bristle, 292–293
customizing, 128, 286–290
diameter, 127, 272, 304, 334
flow rate, 286
hardness, 126, 127
opacity, 127, 286
roundness, 126
saving, 291
settings, choosing, 126
size, changing, 127, 286
tips, 286–290

Burn tool, 113
burning, 247

C
cache (Bridge), 50
Cache preferences (Bridge), 474
calibration, display, 7
Camera Calibration tab (Camera Raw), 61
Camera Raw

Adjustment Brush tool, 57, 74–76
advantages to using, 51–53
Basic tab, 61, 63–67
Camera Calibration tab, 61
clipping adjustment, 64–66
Crop tool, 57, 58
default settings, restoring, 61
Detail tab, 61
dialog illustration, 55
editing layers in, 56
Effects tab, 61, 84–85
Graduated Filter tool, 57, 86–87
HDR file processing in, 251
host selection for, 54
HSL/Grayscale tab, 61, 72–73
image alignment, 79
Lens Corrections tab, 61, 78–83
luminance, reducing, 70

noise reduction, 52
opening files from, as Smart  

Objects, 263
opening layers in, 56
opening photos into, 54–55
placing files from, as Smart Objects, 

264
presets, applying, 91
presets, saving, 91
Presets tab, 61
previews, 52, 57, 61
Radial Filter tool, 88–89
Red Eye Removal tool, 57
saturation adjustments, 67
settings, applying to multiple  

photos, 92
settings, removing, 92
settings, saving as preset, 91
settings, synchronizing, 93
Settings menu, 62, 91
shadow clipping, 66
sharpening, 52, 70
Snapshots, 61, 91
Split Toning tab, 61, 77
Spot Removal tool, 57, 90
Straighten tool, 57, 59
Targeted Adjustment tool, 57,  

68–69, 73
tonal redistribution, 52
Tone Curve tab, 61, 68–69
tools, 57
updating, 53
white balance, 62
White Balance tool, 57
workflow settings, 60
zoom methods, 57

Camera Raw Filter, 56, 251
cameras

Adobe RGB color space, 5–6
capturing tonal values (Camera 

Raw), 52
downloading photos from (Bridge), 

24–25
canvas

area, enlarging with Crop tool, 144
pixels outside of, 255
size, changing, 138
view, rotating, 101

Canvas Size dialog, 138
channels

alpha, 178, 184, 331, 426
Curves adjustment layer, 238
defined, 2

document color mode and, 3
spot color, 390

Channels panel

illustrated, 116
Load Channel as Selection button, 178
New Spot Channel command, 390
Photoshop color modes and, 2–4
Save Selection as Channel button, 178

Character panel

Baseline Shift controls, 381
Color swatch, 377
displaying, 117
East Asian Features, 375, 471
Font Family menu, 377
Font Size menu, 378
Font Style menu, 377
illustrated, 117, 373
Kerning menu, 379
Leading controls, 380
Middle Eastern Features, 375, 471
OpenType buttons, 381
resetting, 379
showing, 377
South Asian features, 471
Tracking controls, 379

Character Style Options dialog, 384
Character Styles panel

illustrated, 117
Load Character Styles command, 385
Load Default Type Styles  

command, 385
New Character Style button, 383
Redefine Character Style by Merging 

Override button, 384
Save Default Type Styles  

command, 385
chromatic aberration correction 

(Camera Raw), 82–83
Clipboard

New dialog and, 16
with Paste command, 254
with Paste Into command, 256
purging, 254
using, 253–256

clipping

adjustments, 219
high-contrast display of, 236
layers, 343–344

clipping masks

creating, 343–344
grouped layers in, 344
releasing, 344
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releasing layers from, 344
using, 343–344

Clone Source panel

clone source overlay settings, 277
illustrated, 118
using, 276–277

Clone Stamp tool

defined, 112
using, 276–277, 316–317

cloning, 
combining images by, 276–277
retouching by, 316–317

CMYK Color mode

channels, 3
conversion, 3, 10, 485
defined, 3, 4
output, final corrections in, 215
soft-proofing, 477
working space, 485

CMYK color model

in color selection, 200
defined, 2

collections (Bridge)
adding to Favorites panel, 46
contents, displaying, 46
deleting, 46
relinking missing files to, 47
from search results, 45
Smart, creating and editing, 46
standard, adding/removing 

thumbnails, 47
standard, creating, 47
types of, 46

Collections panel (Bridge)
in creating and using collections, 

46–47
defined, 26, 46

Color Balance adjustments, 230–231, 
331

color corrections

auto, 228–229
Color Balance adjustment, 230–231
Curves adjustment, 236–239
display calibration and, 215
Hue/Saturation adjustment, 232
Match Color command, 300–301
Photo Filter adjustment, 227
Vibrance adjustment, 233–235

color depth, 2, 17
color depth (Camera Raw), 60
color fringe corrections (Camera  

Raw), 82–83

Color Libraries dialog, 199, 201
color management

benefits of using, 5
calibrating display, 7
Color Handling menu, 480, 481
color modes and, 3–4
color settings, 8–9, 11
introduction to, 5–7
Output options, 482
Photoshop, benefits of, 481
policies, customizing, 10
settings, 480
turning off for printer, 483–484

color modes, document

Bitmap, 4
changing, 362
channels and, 3
CMYK Color, 3, 4, 215
conversions, 3
Grayscale, 4
Indexed Color, 4
Lab Color, 4
RGB Color, 3, 4, 215, 475
selecting, 15
Smart Filters and, 362

Color panel

choosing colors with, 202
illustrated, 118, 202
out-of-gamut alert, 202

Color Picker

choosing colors with, 200–201
HUD, 200
opening, 118
out-of-gamut alert, 202
replacement color, 377

color profiles

assigning, 35
changing, 8, 12
converting, 12
defined, 5
mismatch, 10, 35
missing, 10, 35
removing, 12
selecting, 15
for soft proof, 476–477

Color Range command, 174–176
color reduction algorithms, 493
Color Replacement tool

defined, 112
in red-eye removal, 307
using, 304–305

Color Sampler tool, 112

Color Sampler tool (Camera Raw), 57
color settings

choosing, 8
installing, 11
saving, 11
synchronizing, 9

Color Settings dialog

accessing, 8, 10, 11
in color policy customization, 10
color space selection in, 8
Missing Profiles option, 10
Profile Mismatches option, 10
saving color settings in, 11
Settings menu, 8, 485
Working Spaces area, 485

Color Settings dialog (Bridge), 9
color spaces

Adobe RGB, 5–6, 8
choosing, 8
defined, 5
setting, 6

color-blind viewer design, 209
color(s)

Background, 199
basic methods of choosing, 199
blending modes, 205–206
as building blocks, 2
choosing, 199–204
choosing from color libraries, 201
choosing from HUD color picker, 200
choosing from Swatches panel, 203
choosing with Color Picker, 199, 

200–201
copying as hexadecimals, 204
depth (Camera Raw), 60
desaturating, 234, 235, 240–241
fill layers, 207
Foreground, 199, 200
layer, assigning to, 158, 159
layer mask, 187
process, 200–201
proofing, 476–477
rendering intents, 477, 480
replacing, 302–303
restoring, selectively, 235
sampling with Eyedropper tool, 204
spot, 200, 201
type, 377

commands (action)
adding, 432
adding modal controls to, 433
deleting, 436
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duplicating within/between  
actions, 432

settings, changing, 436
commercial printing

file preparation for, 477, 485
workflow for, 485

Conditional Action dialog, 434–435
Contact Sheet II command, 444–445
Content panel (Bridge)

defined, 26
in folder display, 30
metadata display in, 37
search results, 45
thumbnail display, 32, 34

Content-Aware fill, 319
Content-Aware Move tool

defined, 112
moving/reshaping with, 320–321

Content-Aware scaling, 350–351
context menus

Layers panel, 153
using, 110

contrast

auto adjustment, 229
Brightness/Contrast adjustment, 226
Curves adjustment, 236–237
Levels adjustment, 224–225
midtones, 246
Shadows/Highlights adjustment, 

244–246
contrast adjustments (Camera Raw)

adjustments, 64–69
edge, 67

Convert Point tool, 113, 422
Convert to Profile dialog, 12
converting

Background to layer, 150
color profiles, 12
layer to Background, 150
layer to grayscale, 240–242
layers to Smart Objects, 262
RGB files to CMYK files, 485
shape layers to pixel layers, 411
type, paragraph to point/point  

to paragraph, 378
vector masks to layer masks, 415

copying

action commands, 432
imagery to new layer, 255
layer effects, 400
layer masks, 190
layer settings, 255

layer styles, 403
layers, 163
pasting, 254
path listings, 423
selection borders, 169
selections, 253–258
shapes, 412
Smart Filters, 363
stroke and fill settings on shapes, 411
text styles, between documents, 385
vector masks, 414

Creative Cloud

syncing Photoshop settings via, 
497–498

managing files via, 498–499
crop box

choosing options for, 140
cropping to, 142
guide lines within, 140
resizing, 139, 142
restoring, 139
selection in defining, 143

Crop tool

Camera Raw, 57, 58
crop box reset, 140
cropping image, 139
cropping multiple images, 142–144
cropping to aspect ratio, 142
cropping to crop box, 142
cropping to size and resolution, 142
defined, 112
enlarging canvas area, 144
overlay options, 140
preview options, 140
recording use of, 429
saving settings as preset, 143
shield options, 140
sticky settings, 143
straightening images with, 145

cropping

to aspect ratio, 142
to crop box, 142
manually, 139
nondestructive, 140
to specific size and resolution, 142
trim areas, 144

.csf files, 11, 477
Cursors preferences, 111, 311, 468
Curves adjustment layer

applying, 236–239
color correction with, 238
in darkening midtones, 218

Targeted Adjustment tool, 236, 238
tonal adjustments with, 236–237
See also adjustment layers

Curves Display Options dialog, 236
Custom Shape tool

in adding watermarks using, 442
creating shape layers using, 407–408
defined, 113

Customize Proof Condition dialog, 476

D
Darken blending mode, 314–315
Delete Workspace dialog, 107
desaturation, 234–235, 240–242
Detail tab (Camera Raw)

defined, 61
using, 70–71

DIC Color Guide, 201
Diffuse Glow filter, 367
Digimarc, 443
dimensions

document, 133–137
selection, 166
Web output, 13, 16

Direct Selection tool, 113, 422
displays, calibrating, 7, 215
distortion

geometric (Camera Raw), 78, 79–81
layer, 348–349
Liquify filter, 354–356
Puppet Warp, 352–353
Warp, 358
See also transformations

distributing layers, 275
dithering, in GIF optimization, 493
DNG files (Camera Raw), 94
docks, panel

collapsing, 104
creating, 105
floating, 105
hidden, displaying, 103
reconfiguring, 104–105

document windows

displaying one image in two, 98
docking/floating, 97
multiple, scrolling/zooming in, 101
repositioning images in, 100, 101
resizing, 98
screen modes in, 102
selecting layers or layer groups  

in, 151
Status bar, 21
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tiling, 98
documents

blank, creating, 15–16
closing, 22
creating from file thumbnails, 262
creating from history states, 198
creating from layers, 260
dimensions, 133–137
dragging files into, as Smart Objects, 

264–265
flattened, 164
information, getting quickly, 21
open, displaying specs of, 16
opening as tabs, 97
pixel scale ratio, 21
presets, creating, 16
profiles, 21
resolution, 133–137
reverting to last version, 18–20
saving, 18–20
size, 21
state, restoring, 193
Status bar, 21
type styles, loading, 385

dodging, 247
downloading photos (Bridge), 24–25
drag-copying 

layers, 258–261
selections, 257–259

drawings, changing photos into, 368, 
372

Drop Shadow layer effect

in adding depth, 369
applying, 396–397
in rusted metal type, 384
transforming, 397

droplets for actions, 430
Duplicate Layer dialog, 149, 260
duplicating

actions, 431
Background, 294
layer comps, 448
layers and layer groups, 149
Smart Objects, 267–268
See also copying

E
Edit menu

Assign Profile command, 12
Auto-Align Layers command, 

280–281
Clear command, 168, 256

Color Settings command, 8, 10, 11, 
303, 477, 485

Content-Aware Scale command, 
350, 351

Convert to Profile command, 12
Copy command, 253, 254, 256
Copy Merged command, 254, 256
Cut command, 168, 253–254
Define Custom Shape command, 

128, 421, 442
Define Pattern command, 128, 213
Fill command, 129, 213–214, 221, 

319, 333
Free Transform command, 348, 349
Free Transform Path command, 348, 

423
Menus command, 106
Paste command, 254, 255, 264, 421
Paste Special command, 254, 256
Presets command, 130, 131
Puppet Warp command, 352–353
Purge command, 194, 254
Transform Path submenu, 423
Transform submenu

Distort command, 388, 397
Flip commands, 146
Perspective command, 388
Rotate commands, 146
Warp command, 356, 381

Edit menu (Bridge)
Creative Suite Color Settings 

command, 9
Develop Settings command, 92
Find command, 46

Edit Smart Collection dialog  
(Bridge), 46

editable type layers

creating, 374–375
defined, 122
fading, 380
filling, 386
merging, 162
preserving, 388
See also type

Effects tab (Camera Raw)
defined, 61
grain texture application, 84
vignette application, 85

Ellipse tool, 113, 407–411
Elliptical Marquee tool

in creating selections, 166
in creating vignettes, 437, 438
defined, 112

in deselection, 168
fixed ratio/dimensions selection, 166
in frame-shaped selections, 177
Options bar, 166, 437, 438

Embedded Profile Mismatch alert, 35
Emboss layer effect, 394–395
Eraser tool

defined, 113
using, 296

Erodible Point tips, 289–290
Essentials workspace (Bridge), 28, 29
Every-Line Composer, 382
Export/Import Presets dialog, 130
exporting

Bridge cache, 50
color swatches, for use in other 

applications, 203
preset libraries, 130

exposure correction (Camera Raw)
adjustments, 64–66
Basic tab, 270, 271

exposures, combining, 248–251, 
270–272

Eyedropper tool

defined, 112
sampling colors with, 204

eyes, whitening, 306

F
Favorites panel (Bridge), 26, 30
Field Blur filter

applying, 326
mask, using, 331
pins, 327, 330
using, 327

file formats

Photoshop feature preservation, 18
in saving files, 18–20, 488–490
Web, 491–496

File Handling preferences, 464–465
File menu

Automate submenu
Contact Sheet II command, 444
Create Droplet command, 430

Browse in Bridge command, 9
Close command, 22
Exit command, 22
New command, 15, 16, 256
New Dialog command, 148
Open as Smart Object command, 263
Open command, 34, 486
Open Recent command, 34
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Place command, 265, 486, 487
Print command, 478
Revert command, 18, 193
Save As command, 12, 18, 20, 137, 

164, 485, 487–489
Save command, 18
Save for Web command, 491–496
Scripts submenu, 401

File menu (Bridge)
New Window command, 28
Open Recent command, 34

File Type Associations preferences 
(Bridge), 474

files

dragging into documents as Smart 
Objects, 264–265

8-bit, 17
getting into Illustrator, 486–487
getting into InDesign, 486, 487
managing via the Creative Cloud, 

498–499
opening as Smart Object, 263
opening from Camera Raw as Smart 

Object, 263
optimized, 491–496
placing into Photoshop as Smart 

Objects, 264–265
preparing for commercial printing, 485
resampling, 133, 135–137
resolution, 13–14, 133–137
saving for the Web, 491–496
saving in PDF format, 488
16-bit, 17
32-bit, 17, 21
versions, saving, 20
video, 452
ZIP, 490

files (Bridge)
assigning keywords to, 38–39
batch-renaming, 44
cache, 50
copying, 43
deleting, 43
managing, 38–39
moving, 43
opening, 34–35
opening from Mini Bridge, 49
previewing, 48
quick search, 45
renaming, 43
reopening, 34
searching for, 45
searching for via Mini Bridge, 50

files (Camera Raw)
choosing workflow options for, 60
copy, opening, 94
JPEG files versus raw, 53
opening into Photoshop, 94, 263
previewing, 52
saving, 94
TIFF files versus, 51, 53

Fill dialog, 213, 214, 319
fill layers

blending mode, 207–209
color, changing, 207
defined, 122
Gradient, 208
opacity, 207–209
Pattern, 209
Solid Color, 180, 207

Filter Gallery

accessing, 360, 362
dialog illustration, 361
using, 360–361

filter masks

creating, 364
deactivating, 364
deleting, 364
editing, 364–366
gradient in, 366

Filter menu

Blur submenu
Field Blur command, 326, 327, 330
Gaussian Blur command, 314
Iris Blur command, 326, 328, 331
Lens Blur command, 324
Motion Blur command, 334
Surface Blur command, 313
Tilt-Shift command, 326, 329

Brush Strokes submenu, 405
Convert for Smart Filters command, 

362
Filter Gallery command, 360, 361, 371
Lens Correction command, 332, 439
Liquify command, 354–357
Oil Paint command, 370, 371
Other submenu, 366
Sharpen submenu

Shake Reduction command, 
341–342

Smart Sharpen command, 336–338
Unsharp Mask command, 339–340

Stylize submenu, 368, 372
Filter panel (Bridge)

defined, 26

in thumbnail display, 41
filters

adjustment layers and, 367, 368
applying, 359–361
applying as Smart Filter, 362
applying via Filter Gallery, 360–361
blending modes and, 368
Blur Gallery, 326–331
Diffuse Glow, 367
effects, replacing, 360
Field Blur, 326, 327, 331
Find Edges, 368
Foreground/Background colors, 360
Gaussian Blur, 314–315
Iris Blur, 326, 328, 331
last used, reopening, 360
Lens Blur, 323–325
Lens Correction, 332–333, 439
Liquify, 311, 354–357
Maximum, 366
memory problems and, 364
Minimum, 366, 368
Motion Blur, 334–335
Oil Paint, 370–371
Palette Knife, 371
preview feature, 361
reapplying, 360
Shake Reduction, 341–342
Smart Sharpen, 336–338
Spatter, 405
Surface Blur, 313
techniques for using, 367–369
Texturizer, 369
Tilt-Shift, 326, 329, 331
unavailable, 359
Unsharp Mask, 339–340
uses, 359
video clip application to, 457

Find dialog (Bridge), 45
Find Edges filter, 368
flattening

layer effects, 401
layers, 164

flipping

clone source overlay, 277
layers, 146

FOCOLTONE colors, 201
folders (Bridge)

adding to Favorites panel, 30
copying, 43
creating, 43
current, exporting Bridge cache for, 50
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deleting, 43
displaying cache file icons in, 50
moving, 43
navigating to, 30
purging cache files from, 50

Folders panel (Bridge), 26, 30
fonts

family and style, changing, 377
missing fonts alert, 35
size, changing, 378
vector outlines, 375

Foreground color

choosing, 199–204
filters that use, 360

Freeform Pen tool

defined, 113
using, 416

Full Screen Mode, 102, 103

G
gamma, calibration, 7
Gaussian Blur filter, 314–315
General preferences, 460–461

Export Clipboard, 253–254, 460
History Log, 461
HUD Color Picker option, 460
illustrated, 461
Image interpolation option, 460
Options, 460
Place or Drag Raster Images as Smart 

Objects, 264, 460
Resize Image During Place, 264, 460
Snap Vector Tools and Transforms to 

Pixel Grid option, 408
Vary Round Brush Hardness Based on 

HUD Vertical Movement, 127, 460
General preferences (Bridge), 472
geometric distortion, correcting 

(Camera Raw), 78–81
GIF format

advantages and disadvantages, 491
optimizing file in, 493–494
preview options, 496

Golden Ratio, in cropping images, 140
Gradient Editor dialog

illustrated, 211
opening, 210, 242
in tinting images, 242–243

Gradient Fill dialog, 129, 208, 211
Gradient fill layers

applying gradients via, 211
creating, 208–209
settings, editing, 209

Gradient Map adjustments, 242–243
Gradient Overlay layer effect, 398–399
Gradient tool

applying gradients via, 212
defined, 113
editing filter effect via, 364, 366
editing layer mask via, 273–274
Options bar, 212, 273, 323

gradients

applying via fill layer, 208–211
applying via Gradient tool, 210–212
applying via Gradient Overlay  

effect, 398-399
creating, 210–211
defined, 208
effects, complex, 211
in filter mask, 366
layer mask, 273–274
loading, 129, 131
repositioning, 399
saving, 129, 131

Graduated Filter tool (Camera Raw), 
57, 86–87

grayscale

converting images to, 240
converting layer to, 240–248

Grayscale mode, 4
grid

preferences, 468
showing/hiding, 284

Guides, Grid & Slices preferences, 
282, 470

H
hair selection, 180–183
Hand tool

Camera Raw, 57
defined, 114
in repositioning images, 100, 101
temporary, 100

HDR (High Dynamic Range) images

Merge to HDR Pro command, 
248–250

processing in Camera Raw, 251
producing, 248–251

HDR Toning command, 251
Healing Brush tool

defined, 112
hot spot removal, 310
using, 308–310
wrinkles, softening, 308, 309

highlights

Color Balance adjustment, 231

with Levels adjustment, 224
lightening, 237
in Shadows/Highlights command, 246

Histogram panel

illustrated, 119
using, 222–223

History Brush tool

defined, 113
History panel with, 119
using, 297–298

History Options dialog, 192, 195
History panel

defined, 191
Delete Current State button, 194
History Brush tool with, 297–298
illustrated, 119
linear mode, 191, 192, 193
New Document from Current State 

button, 198
New Snapshot option, 196
nonlinear mode, 192, 193
number of states, 192
options, 191–192

history states

changing, 193
clearing or purging, 194
deleting, 119, 194
document creation from, 198
number of, 192
snapshots of, 194–197

HKS colors, 201
Horizontal Type Mask tool, 113
Horizontal Type tool

in changing font size, 378
creating type with, 374–375
defined, 113
recoloring type with, 377
selecting type with, 376

HSB color model, 202
HSL/Grayscale tab (Camera Raw), 61, 

72–73
HUD color picker, 200
Hue/Saturation adjustments

applying, 232
for increasing saturation, 219
range, setting, 233
Targeted Adjustment tool, 232

I
Illustrator, Adobe

art, pasting into Photoshop, 264
art, path/shape creation from, 421
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opening/placing Photoshop Layer 
into, 487

Photoshop to, 486
Image menu

Adjustments submenu, 216
HDR Toning command, 251
Match Color command, 300
Replace Color command, 302
Shadows/Highlights 

command, 244
Canvas Size command, 138
Image Rotation commands, 101, 146
Image Size command, 254
Mode submenu, 3
Trim command, 144

Image Processor command, 490
Image Size dialog

Auto Resolution option, 136
downsampling for print size, 137
downsampling for Web output, 137
image resolution, changing for print 

output, 134
image upscaling for print output, 135

images

color as building block of, 2
cropping, 139–143
downsampling, 137
flipping, 146
HDR, 248–251
for layer effects, 393
maximum size, 13
moving, in document window, 100, 

101
multichannel, 4
multiple, cropping, 142–143
PDF presentation of, 446–447
playing actions on, 427, 428–429
previews (Bridge), 30–33
print resolution, 14, 133–137
protecting via copyright, 442–443
resizing (Camera Raw), 60, 80
resolution, 133–137
rotating, 146
rotating (Camera Raw), 80
straightening, 145
upscaling for print output, 135
watermarks, 442–443
Web resolution, 13, 137

Import Options dialog, 487
importing

files as Smart Objects, 263–265
preset libraries, 129, 130

type as Smart Object, 375
video files, 452

InDesign, Adobe

Photoshop to, 486
placing Photoshop layer into, 487

Indexed Color mode, 4
Info panel, 120
inkjet printing

outputting files for, 478–484
printer driver settings, 478–479
RGB Color mode for, 475
soft proofing documents for, 476

Inner Glow layer effect, 384
Inner Shadow layer effect, 384, 396
Insert Menu Item dialog, 432
Interface preferences, 97, 102, 110, 

462–463
illustrated, 463
Options, 462

inverting 

layer masks, 187
selections, 173

Iris Blur filter

applying, 326
mask, using, 331
selections with, 327
using, 328

isolating layers, 160–161

J
JPEG files

importing into Photoshop as Smart 
Objects, 263–265

opening (Bridge), 34
opening into Camera Raw, 54–55
optimizing, 491–496
raw files versus (Camera Raw), 51, 53
saving, 20
saving raw files as (Camera Raw), 94

K
kerning type, 379
keyframes, 451, 457
Keyword preferences (Bridge), 474
keywords (Bridge), 38–39
Keywords panel (Bridge)

assigning keywords in, 39
creating keywords in, 38
defined, 26

Kuler panel, 121

L
Lab Color mode, 4
labels, thumbnail (Bridge), 40

Labels preferences (Bridge), 474
Lasso tool

defined, 112
in deselection, 168
in free-form selections, 167

launching

Bridge, 23
Bridge, from Mini Bridge, 48
Photoshop, 1

Layer Comp Options dialog, 448
layer comps

creating, 121, 448
defined, 121
deleting, 450
displaying, 448–449
duplicating, 448
PDF presentation of, 450
updating, 449

Layer Comps Options dialog, 121
Layer Comps panel

Delete Layer Comp button, 450
illustrated, 121
Last Document State listing, 449
New Layer Comp button, 448
Restore Last Document State 

command, 449
Update Layer Comp button, 449

Layer Comps to PDF dialog, 450
layer effects

applying, 391–392, 393
applying to screened back type, 387
Bevel, 394–395
copying, 400
default settings, 393
Drop Shadow, 384, 396–397
Emboss, 394–395
essentials, 391–393
flattening, 401
Gradient Overlay, 398–399
hiding/showing, 392
imagery choices for, 393
Inner Glow, 384
Inner Shadow, 384, 396
live aspect of, 400
moving, 400
Outer Glow, 384, 406
Pattern Overlay, 399
Pillow Emboss, 395
rasterizing, 405
removing, 400
Satin, 399
scaling, 399
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settings, changing, 392
settings, saving, 395
Stroke, 398
types of, 391

layer groups

in clipping mask, 344
creating, 152–153
deleting, 154
duplicating, 149
hiding/showing, 314
locking, 157
moving layers out of, 153
opacity, changing, 156
renaming, 150
restacking, 152
selecting, 151, 260
ungrouping, 154

layer masks

adding via Layers panel, 186
adjustment, editing, 221
applying, 190
blending exposures via, 272
color, changing, 187
converting vector masks to, 415
copying, 190
creating, 186
defined, 186
deleting, 190
density adjustment, 188
disabling, 190
edges, refining, 189, 259
editing, 187–189
editing on adjustment layers, 221
editing with Brush tool, 274
enabling, 190
feather adjustment, 188
gradients in, 273–274
inverting black and white areas in, 187
loading, 190
moving, 190
outputting selections as, 178–179, 186
repositioning, 189, 437
reshaping, 187
shortcuts for, 221
working with, 189–190

Layer Style dialog

Angle setting, 392
Bevel and Emboss, 394–395
Blending Options, 346–347
Contour presets, 392
Drop Shadow, 396–397
Gradient Overlay, 398–399

illustrated, 392
Inner Shadow, 396
for layer styles, 402
opening, 346, 391, 393
Pattern Overlay, 399
Stroke, 398

layer styles

applying, 402
copying, 403
creating, 403
with Layer Styles dialog, 402
rasterizing, 405
removing, 402
saving, 129, 131, 403

layers

aligning, with one another, 275
aligning, using Smart Guides, 155
blank, adding, 148
blending modes, 206, 345–347
blending options, 346–347
clipping masks, 343–344
color-coding, 157
content, repositioning, 189
converting to Smart Object, 262
copying and merging, 163
creating, 148–150
deleting, 154
desaturating, 234, 235
distributing, 275
document creation from, 260
drag-copying, between files  

(Layers panel), 260–261
drag-copying between files  

(Move tool), 258–259
duplicating, 149
edges, fading via gradient in  

layer mask, 273–274
editable type, 122, 374–375
editing via Camera Raw Filter, 56
file formats that support, 362
file size and, 164
fill, 122, 207–209
Fill opacity percentage, 401
filtering, 158–161
flattening, 164
flipping, 146
hiding/showing, 147, 154
image, 122
isolating, 160–161
locking, 157
merging, 162
moving out of groups, 153

multiple, selecting, 151
naming, 149
nontransparent areas, selecting, 165
nudging one pixel at a time, 155
opacity, changing, 156, 401
pixel selection conversion into, 149, 

178–179
releasing from isolation, 160
renaming, 148, 150
repositioning, 155
restacking, 152
rotating, 146
scaling, 348–351
screening back, 252
selecting, 151, 165
selecting, in document window, 151
shape, 122, 407–422
straightening, 145
visible, merging, 163
warping, 356
See also adjustment layers

Layers panel

Add Layer Mask button, 186, 272, 
273, 280–281, 313, 323, 372, 437

Add Layer Style menu, 391
Add Vector Mask button, 414
Advanced Blending badge, 347
Apply Layer Mask option, 190
Background, 147, 150
blending modes, 206
Blending Options, 363
context menus, 153
Convert to Smart Object option, 262
Create Fill/Adjustment Layer menu, 

207, 208, 216–217
Delete Layer button, 220, 400
Delete Layer Mask option, 190
display options, 157
drag-copying layers with, 260–261
Duplicate Layer command, 163
Fill setting, 401
filtering options, 158–161
Filter Type menu, 161
Flatten Image command, 164
illustrated, 122
Layer Filtering On/Off button, 158, 161
layer mask creation with, 186
listings, filtering, 158–161
Lock Transparent Pixels button, 156, 

286, 298
Merge Down command, 162, 220
Merge Visible command, 163
New Group button, 152
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New Group from Layers  
command, 152

New Layer button, 148, 149, 247
options, 157
selecting layers via, 151
thumbnail options, 157
uses, 122
Video Group listing, 457

leading, 380
Lens Blur filter, 323–325
Lens Correction filter

applying, 332–333
Auto Correction tab, 332
Custom tab, 333, 439
vignette creation via, 439

Lens Corrections tab (Camera Raw)
color fringe corrections, 82–83
defined, 78
Manual settings, 79–81
for multiple photos, 81
Profile settings, 78
using, 78–83

Levels adjustment layer

illustrated effects, 224
mask, 387
screening back layers with, 252
settings, applying, 224
tonal values correction with, 224–225
See also adjustment layers

Light Table workspace (Bridge), 28, 29
Lighten blending mode, 314–315
Liquify filter

applying to Smart Objects, 356
distortion tools, 354–356
edits, removing, 356
protecting image areas from, 354
Reconstruct Options, 356
for retouching, 357

locking

layers or layer groups, 157
transparent pixels, 156

loupe (Bridge), 32
luminance (Camera Raw), 70–71

M
Mac OS

Application frame, 96
launching Bridge in, 23
launching Photoshop in, 1
quitting Photoshop in, 22
Save As dialog, 19
ZIP file creation, 490

Magic Wand tool

defined, 112
using, 172–173

masks

clipping, 343–344
creating, 186
density, 188
editing, 187–189
feathering, 188, 438
layers, 186–190
options on Properties panel, 124, 

188–189
refining edges of, 189
storing selections as, 185
vignette creation via, 438
zooming in on, 184
See also filter masks; layer masks; 

Quick Masks; vector masks
Match Color dialog, 300–301
Maximum filter, 366
Merge to HDR Pro dialog

Advanced tab, 248, 249
Curves tab, 250
in making images look surreal, 251
Tones and Detail, 248, 249
using, 248–250

merging

adjustment layers, 220
layers, 162
visible layers, 163

metadata (Bridge), 37
Metadata panel (Bridge)

defined, 26
keyword assignment via, 39

Metadata placard (Bridge), 30
Metadata preferences (Bridge), 473
midtones

adjusting separately, 347
auto correction of, 228–229
Color Balance adjustment, 231
contrast, 246
darkening, 217, 218
with Levels adjustment, 224
lightening, 237, 252
range, controlling, 244
reducing blue and green in, 239

Mini Bridge

accessing, 48
defined, 48
docking, 49
file searches via, 50
floating, 49

illustrated, 49
loading files from, 262, 264
opening Camera Raw files from, 55
opening files from, 34, 49, 263
previewing files in, 48

Minimum filter, 366, 368
Missing Profile alert dialog, 35
Mixer Brush tool

Airbrush tip, 290
bristle brush creation, 292
bristle brush paint options, 293
cleaning bristle brushes, 293
defined, 112
Erodible tip, 290
photos into paintings, 294–296
using, 292–296

Monitor RGB color space, 8
Motion Blur filter, 334–335
Motion panel, 455
Motion workspace, 451
Move tool

in adding isolated layers, 161
drag-copying with, 257, 258–259
in layer selection, 151
in moving selection contents, 169
in repositioning layers, 155
Options bar, 255, 260, 275
in repositioning layer mask, 189
scaling type with, 378
transformations with, 348–349

moving

with Content-Aware Move tool, 320
layer effects, 400
layer masks, 190
layers, 155
selection borders or contents, 169
vector masks, 414

N
Navigator panel

functions, 123
illustrated, 123
in repositioning, 100
in zooming, 100

New (document) dialog, 15–16
New Actions dialog, 426
New Crop Preset dialog, 143
New Document Preset dialog, 16
New Layer Comp dialog, 448
New Layer dialog, 150
New Preset dialog (Camera Raw), 91
New Snapshot dialog, 196
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New Spot Channel dialog, 390
New Style dialog, 403
New Tool Preset dialog, 132
New Workspace dialog, 38, 106
noise reduction (Camera Raw), 70–71
North America Prepress 2 preset, 8, 10

O
Oil Paint filter, 370–371
opacity

blending layers, 345
brush, 286
duplicate layer, 372
fill layer, 207–209
fill percentage, 401
in gradients, 210
layer or layer group, 156
overlay, 398, 399
shadow, 396
Smart Object, 365
tool, 205

Open as Smart Object command, 263
OpenGL, enabling, 466–467
OpenType characters, 381
optimized files

format choices for, 491
in GIF format, 493–494
in JPEG format, 495–496
preset, creating, 496
previewing, 492

Options bar

accessing, 108
Brush tool, 184, 187, 221, 247, 286
Clone Source tool, 276
Clone Stamp tool, 316–317
Color Replacement tool, 304, 307
Content-Aware Move tool, 320
Content-Aware Scale command, 350
Crop tool, 139, 140, 144, 145 
Elliptical Marquee tool, 166, 437, 438
Eraser tool, 296
Eyedropper tool, 204
features, 108
Free Transform command, 349
Freeform Pen tool, 414, 416
Gradient tool, 212, 273, 323
Healing Brush tool, 308
History Brush tool, 297–298
Horizontal Type tool, 374, 377, 378
illustrated, 108
Magic Wand tool, 172
Mixer Brush tool, 292, 293, 294

Move tool, 151, 255, 260, 275
numerical values, changing, 117
Patch tool, 312, 322
Pen tool, 414, 418, 419, 421, 422
Puppet Warp command, 352
Quick Selection tool, 170
Rectangular Marquee tool, 166
Red Eye tool, 307
Ruler tool, 145, 284
Sharpen tool, 335
Spot Healing Brush tool, 311
Toggle Brush Panel button, 105
Toggle Character and Paragraph 

Panels button, 377
Tool Preset picker, 111
values, canceling, 108
Vertical Type tool, 374, 377, 378
Warp command, 356
Workspace menu, 102, 106, 107, 108

orientation, type, 380
Outer Glow layer effect, 384, 406
out-of-gamut alert, 202
Output preferences (Bridge), 474
Overlay blending mode, 247

P
paintings

Oil Paint Filter, 370–371
Texturizer filter and, 369
turning photos into, 294–296, 369

Palette Knife filter, 371
panel

Actions, 114, 425–436
Adjustments, 115, 215–220
Adobe Exchange, 115
Brush, 115, 286–290
Brush Presets, 116, 291
Channels, 2–4, 116, 178
Character, 117, 373, 375, 379–381
Character Styles, 117, 383–385
Clone Source, 118, 276–277
Color, 118, 202
Histogram, 119, 222–223
History, 119, 191–198
Info, 120
Kuler, 121
Layer Comps, 121, 448–450
Layers, 122, 147–164, 260–262, 

272–273, 280–281
Mini Bridge, 48–49
Motion, 455
Navigator, 100, 123

Paragraph, 123, 375, 382
Paragraph Styles, 123, 383–385
Paths, 123, 416–417, 421, 423–424
Properties, 124, 187, 190, 216–220
Styles, 125, 402–403
Swatches, 125, 203
Timeline, 125, 451
Tool Presets, 125
Tools, 111–114, 184
Transition, 454

panel groups

closing, 104
floating, 105
maximizing/minimizing, 104
moving, 105
reconfiguring, 104–105

panels

closing, 104
configuring, 103–105
deleting presets from, 128
hidden docks, displaying, 103
hiding, 103, 104
icons, 110
maximizing/minimizing, 104
moving, 105
opening, 103
preset management via, 128–130
redocking into Application frame, 105
restoring default presets to, 130
showing, 103, 104
widening or narrowing, 105

panels (Bridge)
Collections, 26
configuring manually, 36
Content, 26, 37, 45
displaying/hiding, 36
Favorites, 26, 30, 45
Filter, 26, 41
Folders, 26, 30
Keywords, 26, 38–39
Metadata, 26, 39
Preview, 26, 30

panoramas, 278–279
PANTONE colors, 201
Paragraph panel

alignment buttons, 382
controls, 382
East Asian Features, 375, 471
illustrated, 123
justification buttons, 382
Middle Eastern and South Asian 

Features, 375, 471
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Paragraph Styles panel

Clear Overrides button, 383
illustrated, 123
Load Default Type Styles option, 385
Load Paragraph Styles option, 385
New Paragraph Style button, 383
Redefine Paragraph Style by Merging 

Override button, 384
Save Default Type Styles option, 385

paragraph type

converting to point type, 378
creating, 374–375
transforming, 386

Paste Camera Raw Settings dialog, 92
Paste dialog, 264
pasting

files as Smart Objects, 264
Illustrator art into Photoshop, 264
refining selections after, 259
into selections, 256
selections, 254

Patch tool

defined, 112
removing image elements with, 322
retouching with, 312

Path Selection tool

in aligning shapes, 412
defined, 113
Options bar, 409
in uniting shapes, 412
with vector masks, 413, 415

paths

applying fill/stroke colors to, 424
combining, 423
copying, 423
creating from Illustrator, 421
creating from shape layer, 421
creating vector masks from, 413
curved, drawing, 419
deleting, 423
hiding/displaying, 417
loading as selection, 424
nonsmooth curve, drawing, 420
preserving, 423
producing shapes from, 421
repositioning, 417
selecting/deselecting, 417
storing and accessing, 123
straight-sided, drawing, 418
temporary (Work Paths), 416, 417
transforming, 423
working with, 423–424

Paths panel

Delete Path button, 423
Fill Path with Foreground button, 424
illustrated, 123
Load Path as Selection button, 423, 

424
Make Work Path from Selection 

button, 421, 423
path listings, restacking, 423
Stroke Path with Brush button, 424
working with, 416–417

Pattern fill layers, 213
Pattern Overlay layer effect, 399
patterns, scripted, 213–214
PDF format

in Photoshop feature preservation, 19
presentation of images, 446–447
presentation of layer comps, 450
saving files in, 488
selecting, 18

PDF Presentation dialog, 446–447
Pen tool

in adding/deleting points, 422
combining skills, 421
defined, 113
in drawing curved paths/shapes, 419
in drawing nonsmooth curves, 420
in drawing paths, 414
in drawing straight-sided paths/

shapes, 418
Pencil tool, 112
Performance preferences, 466–467

Graphics Processor Settings, 95, 466
History & Cache, 192
Memory Usage, 466
Scratch Disks, 466

perspective

correction, 332–333
transformation, 349

Perspective Crop tool, 112, 142
Photo Downloader (Bridge), 24–25
Photo Filter adjustments, 227
Photomerge command, 278–279
photos

downloading (Bridge), 24–25
sampling colors from, 294
shooting for Merge to HDR Pro 

command, 248
shooting for panorama, 278
turning into oil painting, 370–371
turning into paintings, 294–296
turning into tinted drawing, 372

photos (Camera Raw)
archiving as DNG files, 94
choosing workflow settings for, 60
cropping, 58
grayscale, color tint application to, 77
lens correction synchronization, 81
opening from Camera Raw into 

Photoshop, 94
opening into Camera Raw, 54–55
preferences for opening, 54
rotating, 80
sharpening, 70
Smart Object, editing, 266
straightening, 59
stretching, 80
synchronizing settings for  

multiple, 93
updating, 54
vignette application to, 85

Photoshop

exiting/quitting, 22
getting to quickly (Bridge), 34
launching, 1
updating, 499

Photoshop Import Options dialog, 487
pickers

deleting presets from, 128
loading presets onto, 129, 131
preset management via, 128–130
restoring default presets to, 130
saving presets on, 129
See also specific pickers

Pillow Emboss layer effect, 395
pixels

adding to canvas, 138
erasing, 296
maximum image size in, 13
outside canvas, 255
pasted, 254
rasterizing type into, 388–389
selection, turning into layer, 149
shadow, in histogram, 223
transparent, locking, 156

Place dialog, 269, 486
Place PDF dialog, 264
Placing files from Camera Raw into 

Photoshop, 264
Playback preferences (Bridge), 473
Plug-ins preferences, 470–471
point type

aligning, 374
converting to paragraph type, 378
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creating, 374–375
Polygon tool, 113, 407–408
Polygonal Lasso tool

defined, 112
in straight-sided selections, 167

pop-up sliders, using, 117
PostScript printing options, 482
preferences, 459–474

Cursors, 111, 311, 468
File Handling, 20, 54, 464–465
General, 127, 253–254, 408, 460–461
Guides, Grid & Slices, 282, 470
Interface, 97, 102, 110, 462–463
opening, 459
Performance, 95, 192, 466–467
Plug-ins, 470–471
resetting, 459
Sync Settings, 463
syncing between computers, 497–498 
Transparency & Gamut, 156, 466
Type, 375, 471
Units & Rulers, 16, 469

preferences (Bridge), 472–474
Advanced, 474
Cache, 50, 474
Camera Raw, 54
File Type Associations, 474
General, 30, 472
Keywords, 474
Labels, 474
Metadata, 473
opening, 459
Output, 474
Playback, 473
resetting, 459
Startup Scripts, 474
Thumbnails, 37, 473

preferences (Camera Raw), 54
preset libraries

exporting, 130
importing, 130
loading, 129, 131
saving presets as, 129, 131

Preset Manager

illustrated, 131
loading presets with, 131
opening, 131, 291
saving presets with, 131

presets

adjustment layer, 220
brush, 126, 291

Color Range, 175
creation of, 128
default, restoring, 130
deleting, 128, 131
document, 16
exporting, 130
gradient, 210
importing, 130
loading, 129, 131
naming, 16
optimization, 496
renaming, 131
saving, 16, 131
syncing between computers, 497–498
tools, 132
unsaved, storage, 128

presets (Camera Raw)
applying, 91
saving settings as, 91

Presets tab (Camera Raw), 61
Preview panel (Bridge)

defined, 26
image display in, 30, 32

Preview workspace (Bridge), 28, 29
previews

Camera Raw, 52
filter, 360, 361
GIF/JPEG optimization options, 496
optimized file, 492

previews (Bridge)
comparing, 32
files, in Mini Bridge, 48
full-screen, 32
loupe for examining, 32
quality options, 31
in Review mode, 33
thumbnails, 30

previews (Camera Raw)
histogram clipping warnings, 64
Threshold, 66
toggling, 61
zooming in, 57

Print dialog

accessing, 478
Color Management settings, 480, 

483, 484
illustrated, 481
PostScript Options category, 482
printer driver settings, 478–479
Printing Marks options, 482
settings, 480–482

print output

commercial, 477, 485
downsampling photos for, 137
file resolution, 14, 16, 134
quasi hard proof, 482
scaling, 480
soft proofing for, 476–477
upscaling images for, 135

printers

color management, turning off  
and, 483–484

driver settings, 478–479
profiles, acquiring, 11
rendering intents and, 477

process colors, 200–201
profiles

color, 5, 12, 35
document, 21
printer, 11

proofing colors

for commercial printing, 477
for inkjet output, 476
for Web output, 477

Properties panel

adjustment layer options, 124
Apply Mask button, 190
Auto-Select Parameter option, 219
Black & White controls, 240, 241, 242
Brightness/Contrast controls, 226
Clip to Layer button, 219
Color Balance settings, 230, 231
Curves Display Options, 236
Delete Adjustment Layer button, 220
Delete Mask button, 190
Gradient Map controls, 242, 243
Hue/Saturation controls, 232, 306
illustrated, 124
Invert button, 187
Levels controls, 224, 252
Live Shape Properties button, 409
Load Selection from Mask button, 190
Mask Edge option, 189
mask options, 124
Photo Filter controls, 227
settings, 216–220
Vibrance controls, 233, 234

Properties/Print dialog, 478, 479
ProPhoto RGB color space, 8
PSB files

in Photoshop feature preservation, 19
selecting, 18
working with, 20
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PSD format

in Photoshop feature preservation, 19
saving files in, 490
saving raw files in (Camera Raw), 94
selecting, 18

Puppet Warp command, 311, 352–353

Q
Quick Mask Options dialog, 185
Quick Masks

creating selections via, 185, 306
in reshaping selections, 184

Quick Selection tool

defined, 112
using, 170–171

R
Radial Filter tool (Camera Raw), 88–89
RAM, 21
rasterizing

layer effects and layer styles, 405
Smart Objects, 269
type, 388–389

ratings, thumbnail (Bridge), 40
raw files (Camera Raw)

advantages to using, 51–53
conversion, 60
copy, opening, 94
JPEG files versus, 51, 53
opening into Camera Raw, 54, 55
opening into Photoshop, 94
previewing, 52
saving, 94
TIFF files versus, 51, 53
See also Camera Raw

Record Stop dialog, 431
Rectangle tool, 113, 407–411
Rectangular Marquee tool

in creating selections, 166
defined, 112
in deselection, 168
in frame-shaped selections, 177

Red Eye Removal tool (Camera Raw), 
57, 307

Red Eye tool

defined, 112
using, 307

Refine Edge dialog

accessing, 178
in artistic border creation, 440
Decontaminate Colors, 182, 183
illustrated, 179
layer mask creation with, 186

Output To menu, 179, 182, 186, 440
Refine Radius tool, 182
refining hair selection with, 180–183
refining selection edges with, 178–179
Smart Radius option, 180

Refine Mask dialog, 189, 259
Refine menu (Bridge), 33
refocusing. See blur filters
Render Video dialog, 458
rendering intents, 477, 480
Replace Color dialog, 302–303
resampling files, 133, 135–137
reshaping

bounding box, 386
with Content-Aware Move tool, 320
layer masks, 187
with Liquify filter, 354–357
with Puppet Warp command, 

352–353
selections, 184
shadows, 397
with Warp command, 358

resolution

auto, 136
calculating, 13–14
default values, setting, 16
document, 133–137
image, 133–134
methods of setting, 14
print output, 14, 16, 134
selecting, 15
Web output, 13, 16

retouching

by cloning imagery, 316–317
Color Replacement tool, 304–305
eye whitening, 306
Gaussian Blur filter, 314–315
guidelines, 299
Healing Brush tool, 308–310
Liquify filter, 357
Match Color command, 300–301
Patch tool, 312, 322
Red Eye tool, 307
Replace Color command, 302–303
skin smoothing, 313
Spot Healing Brush tool, 311
Surface Blur filter, 313
teeth whitening, 306

Return to Adobe Photoshop button 
(Bridge), 34

reverting, to last saved document 

version, 18

Review mode (Bridge)
previewing images in, 33
rating thumbnails in, 40

RGB Color mode

channels, 3
defined, 3, 4
for inkjet printing, 475
for Photoshop work, 215

RGB color model

choosing, 202
in color selection, 200
defined, 2, 202

Rotate View tool, 101, 114
rotating

bounding box, 386
clone source overlay, 277
images, 139, 146
items, 349
layers, 146
via Puppet Warp command, 352, 353

Rounded Rectangle tool, 113, 407–411
ruler guides

creating, at specific location, 284
creating by dragging, 283
locking/unlocking, 284
removing, 284

Ruler tool

defined, 112
in measuring distance or angle  

with, 284
straightening layers with, 145

rulers

origin, changing, 283
showing and hiding, 283
units, changing, 283, 469
units, in actions, 426

S
Satin layer effect, 399
saturation adjustments

Basic tab (Camera Raw), 67
Color Replacement tool, 304–305
Hue/Saturation, 219
Vibrance, 233–235
in whitening teeth, 306

Save Adobe PDF dialog, 447, 488
Save As dialog, 18, 19, 20, 164, 487–489
Save dialog, 129
Save for Web dialog

GIF format, 493–494
illustrated, 492, 493, 495
JPEG format, 495–496
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previewing optimized files in, 492
Save Options dialog (Camera Raw), 94
Save Settings dialog (Camera Raw), 91
saving

action sets, 436
adjustment presets, 220
blur masks, 326
Brush Presets panel brushes, 129
brushes, 291
color settings, 11
custom workspaces, 106
document presets, 16
documents, 18–20
flattened documents, 164
files in JPEG format, 490
files in PDF format, 488
files in PSD format, 490
files in TIFF format, 489, 490
layer effect settings, 395
layer styles, 403
multiple files, 490
presets, 129, 131
previously saved documents, 18
Shadows/Highlights settings, 246
for Web, 491
workspaces (Bridge), 38

scaling

clone source overlay, 277
Content-Aware, 350–351
gradients, 399
items, 348
layer effects, 399
layers, 260, 348–351
paths, 348–349
patterns, 399
print output, 480
selections, 348–349
Smart Objects, 264, 265
styles, 136
type, 378

Screen mode menu, 102, 103
screening back layers, 252
screening back type, 387
scripted patterns, 213–214
scrolling, in multiple windows, 101
scrubby sliders, using, 117
searching for files (Bridge), 45
Select menu

All command, 165
Color Range command, 174
Deselect command, 168
Deselect Layers command, 384

Grow command, 173
Inverse command, 173
Isolate Layers command, 160
Reselect command, 168
Similar command, 173
Transform Selection command, 348

selection edges

adjusting, 255
feathering, 257
refining, 179–183

selections

adding to via command, 173
in adjustment layers, 216
border, moving, 169
border, showing/hiding, 176, 322
of colors, 174–176
contents, moving, 169
creating paths from, 421
creating via Quick Mask, 185
creating with Color Range command, 

174–176
deleting, 168
deselecting, 168
drag-copying, between files  

(Move tool), 258–259
drag-copying, on same layer, 257
Elliptical Marquee tool, 166, 177
enlarging, 170
expanding, 173
filling, 168
frame-shaped, 177
free-form, 167
hair, 180–183
inverting, 173
Lasso tool, 167
layer-based, 151, 260
loading, 178
loading layer masks as, 190
loading paths as, 424
loading shape layers as, 411
nontransparent areas of layer, 165
pasting into, 256
Polygonal Lasso tool, 167
Quick Selection tool, 170–171
Rectangular Marquee tool, 166, 177
refining, 178–183
reselecting, 168
reshaping via Quick Mask, 184
saving, 178
shrinking, 170
storing as masks, 185
straight-sided, 167

transforming, 348–349
type, 376
whole layer, 165

Settings menu (Camera Raw)
restoring settings via, 62
saving settings as presets with, 91

shadows

auto correction, 228–229
Brightness/Contrast adjustment, 226
Color Balance adjustment, 230
Curves adjustment, 236–237
dodging and burning, 247
drop (layer effect), 396–397
HDR images, 248–251
Levels adjustment, 224
pixels in histogram, 223
reducing, 245
in Shadows/Highlights command, 

244–246
softening, 337
tinting (Camera Raw), 77

Shadows/Highlights command, 
244–246

Shake Reduction filter, 341–342
shape layers

adding shapes to, 412
aligning shapes within, 412
attributes, changing, 409–411
combining into one layer, 412
creating paths from, 421
creating vector masks from, 413
creating with shape tools, 407–408
defined, 122
excluding/intersecting shapes in, 412
loading as selection, 411
merging, 162
properties, changing, 409–410
properties, copying, 411
subtracting shapes in, 412
uniting shapes in, 412
warp settings, 356
See also vector objects

Shape Name dialog, 421
Sharpen tool

defined, 113
using, 335

sharpening

photos (Camera Raw), 52, 60, 70
Shake Reduction filter, 341–342
Sharpen tool, 113, 335
Smart Sharpen filter, 336–338
Unsharp Mask filter, 339–340
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shortcuts

layer mask, 221
tool setting changes, 127
transform, 349
undo, 109
zoom, 99

Single Column Marquee tool, 112, 166
Single Row Marquee tool, 112, 166
Single-Line Composer, 382
16-bit files, 17
skewing items, 349
skin smoothing

with Gaussian Blur filter, 314–315
with Surface Blur filter, 313

Smart collections (Bridge), 46
Smart Filters

applying, 362
blending options, editing, 363
copying, 363
deleting, 364
editing, 362
example use, 365–366
hiding/showing effects, 363
masking, 364–366
restacking, 363

Smart Guides

aligning layer content with, 155
in moving layers, 282
transformations with, 348

Smart Objects

applying filters to, 362–369
converting layers to, 262
copies, converting into layer, 269
creating, 262–265
defined, 262
dragging files into documents  

as, 264–265
duplicating, 267
editing, 266–268
importing type as, 375
in lieu of merge or flatten, 162
linked copies, editing, 267
linked duplicates, creating, 267
merging, 162
opacity, 365
opening files as, 263
opening files from Camera Raw  

as, 94, 263
rasterizing, 269
replacing, 269
scaling, 265
thumbnails, 267, 268

Smart Quotes, 375
Smart Sharpen filter, 336–338
Snap To feature, 284
snapshots

creation of, 195
deleting, 197
of history state, 196
as newest history state, 197
options, 195
using, 195–197

Snapshots tab (Camera Raw), 91
soft proofs

commercial printing, 477
defined, 475
inkjet, 476

Solid Color fill layers, 180, 207
Spatter filter, 405
Split Toning tab (Camera Raw), 61, 77
splitting video clips, 454
spot colors

channel, putting type in, 390
choosing, 201
defined, 200
separation into process colors, 201

Spot Healing Brush tool

Content-Aware option, 311, 318
defined, 112
using, 311

spring-loading tools, 111
sRGB color space, 8
Standard screen mode, 102, 103
Startup Scripts preferences  

(Bridge), 474
Status bar, 21
Straighten tool (Camera Raw), 57
straightening

images, 145
layers, 145
photos (Camera Raw), 59

stroke, shape layer

copying, 411
restyling, 410
settings, saving, 410

Stroke layer effect, 398
styles, layer

applying, 402
creating, 128, 403
defined, 125
rasterizing, 405
removing, 402
saving, 403
scaling, 136

Styles panel

Clear Style button, 402
illustrated, 125
New Style button, 403, 442
saving styles to, 403
uses, 125

Surface Blur filter, 313
swatches, color

creating, 203
current, using, 203
default, restoring, 203
loading, 129, 131
loading from HTML, CSS, and  

SVG files, 203
predefined/user-defined, 125
saving, 129, 131, 203
text, 377

Swatches panel

adding colors to, 203
choosing colors via, 203
illustrated, 125
Load Swatches command, 203
New Swatch of Foreground Color 

button, 128, 203
Replace Swatches command, 203

Sync Settings preferences, 463, 497
synchronizing

Camera Raw settings, 93
color settings, 9
Photoshop settings via the Creative 

Cloud, 497–498

T
Targeted Adjustment tool

auto-selecting, 240
Black & White adjustment layer, 240
Curves adjustment layer, 236, 238
Hue/Saturation adjustment, 232

Targeted Adjustment tool (Camera 
Raw), 68–69, 73

teeth whitening, 306
textures, grain (Camera Raw), 84
Texturizer filter, 369
Thumbnail preferences (Bridge), 37, 473
thumbnails (Bridge)

adding to collection, 47
adding to stacks, 43
badge, 54
cycling through, 30
displaying, 30, 48
filtering, 41, 48
full-screen preview of, 32
labeling, 33, 40



518  Index

multiple, selecting, 30, 31
numbers, 30
previewing, 32–33
quality options, 31
rating, 33, 40
rearranging, 41
rearranging within stacks, 42
removing from collection, 47
removing from stacks, 43
removing ratings/labels from, 40
resizing, 36
selecting, 30
selecting in stacks, 42
sorting, 48
sorting order for, 41
stacks, 42–43

TIFF files

in feature preservation, 18
opening (Bridge), 34
opening in Camera Raw, 54
raw files versus (Camera Raw), 53
saving, 489
saving multiple files as, 490
saving raw files as (Camera Raw), 94

TIFF Options dialog, 489
Tilt-Shift filter

applying, 326
mask, using, 331
selections with, 327
using, 329

timeline

adding tracks to, 452
defined, 451

Timeline panel

Add Keyframe button, 457
Add Media menu, 452, 455
Add Media to Track button, 452
Audio panel access, 458
Enable Keyframe Animation  

button, 457
illustrated, 125, 451
Motion panel access, 455
Mute Audio Playback button, 453
New Video Group option, 452
opening, 451
Play button, 453
Render Video button, 458
Split at Playhead button, 454
Transition button, 454
in video editing, 451
Video panel access, 453
See also video; video clips

tints

applying to grayscale photos 
(Camera Raw), 77

Black & White adjustment, 240, 242
Gradient Map adjustment, 242–243

title clips, 455
tonal adjustments

Basic tab (Camera Raw), 63–66
Black & White adjustment, 240–242
Brightness/Contrast adjustment, 226
Curves adjustment, 236–237
dodging and burning, 247
Levels adjustment, 224–225
redistribution (Camera Raw), 52
Shadows/Highlights command, 

244–246
Tone Curve tab (Camera Raw), 68–69
vignette creation via, 438

Tone Curve tab (Camera Raw)
defined, 61
using, 68–69

Tool Preset picker, 111, 132
tool presets

creating, 128, 132
Crop tool, saving as, 143
default, restoring, 132
defined, 125

Tool Presets panel, 125, 132
tool tips

metadata in, 37
preferences, 462
using, 110

tools

Add Anchor, 113
Art History, 113
Background Eraser, 113
Blur, 113
Brush, 112, 127, 247, 285–290
Burn, 113, 247
Clone Stamp, 112, 276–277, 316–317
Color Replacement, 112, 306
Color Sampler, 112
Content-Aware Move, 112, 320–321
Convert Point, 113, 422
Count, 112
Crop, 112, 139–140, 142–144
Custom Shape, 113, 407–408, 442
Delete Anchor, 113
Direct Selection, 113, 422
Dodge, 113, 247
Ellipse, 113, 407–411
Elliptical Marquee, 112, 166, 168, 437

Eraser, 113, 296
Eyedropper, 112, 204
Freeform Pen, 113, 416
Gradient, 113, 210, 212, 273
Hand, 100, 101, 114
Healing Brush, 112, 308–310
hints, 111
History Brush, 113, 119, 297–298
Horizontal Type, 113, 374–375, 376
Horizontal Type Mask, 113
Lasso, 112, 167
Line, 113
Magic Eraser, 113
Magic Wand, 112, 172–173
Magnetic Lasso, 112
Mixer Brush, 112, 292–296
Move, 151, 169, 189, 255, 257, 

258–259, 260, 348–349
Note, 112
opacity, 205
Options bar settings, 111
Paint Bucket, 113
Patch, 112, 312, 322
Path Selection, 113, 409, 412, 415
Pattern Stamp, 112
Pen, 113, 418–420, 422
Pencil, 112
Perspective Crop, 112
Polygon, 113, 407–408
Polygonal Lasso, 112, 167
Quick Selection, 112, 170–171
Rectangle, 113, 407–411
Rectangular Marquee, 112, 166,  

168, 440
Red Eye, 112, 307
Rotate View, 101, 114
Rounded Rectangle, 113, 407–411
Ruler, 112, 145, 284
selecting, 111
Sharpen, 113, 335
shortcuts for changing settings, 127
Single Column Marquee, 112, 166
Single Row Marquee, 112, 166
Slice, 112
Slice Select, 112
Smudge, 113
Sponge, 113
Spot Healing Brush, 112, 311, 318
spring-loading, 111
Targeted Adjustment tool, 232, 236, 

238, 240
Targeted Adjustment tool (Camera 

Raw), 68, 73
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3D Material Drop, 113
3D Material Eyedropper, 112
Vertical Type, 113, 374–375
Vertical Type Mask, 113
Zoom, 99, 101, 114

tools (Camera Raw), 57
Adjustment Brush tool, 74–76
Graduated Filter tool, 57, 86–87
Radial Filter tool, 88–89
Red Eye Removal tool, 57, 307
Spot Removal tool, 57, 90
Targeted Adjustment tool, 68

Tools menu (Bridge)
Batch Rename command, 44
Cache command, 50
Photoshop submenu

Batch command, 427
Contact Sheet II command, 

444–445
Image Processor command, 490
Load Files into Photoshop 

Layers command, 262
Merge to HDR Pro command, 248
Photomerge command, 278
Process Collections command, 278

Tools panel

Change Screen Mode option, 114
cycling through tools on, 111
Edit in Quick Mask Mode option, 114, 

184, 185
Edit in Standard Mode button, 184
Foreground and Background color 

options, 114
illustrated, 112–114
Screen Mode menu, 102, 103
using, 111
See also tools

TOYO Color Finder, 201
tracking type, 379
tracks, video

adding to timeline, 452
applying adjustment layer to, 456
audio, 458
deleting, 453
See also video

transformations

Drop Shadow layer effect, 397
with Free Transform command, 

348–349
layer, path, or selection, 348–349
with Move tool, 348–349
paragraph type, 386

path, 423
selection border, 169
shortcuts, 349
with Smart Guides, 348
type, 378, 386
via Options bar, 349

Transition panel, 454
transitions, video

adding, 454
defined, 451
duration, adjusting, 454
See also video

Transparency & Gamut  

preferences, 156, 466
transparency in GIF, 491, 493
Trim command, 144
TRUMATCH color system, 201
type

aligning, 374, 382
anti-aliasing, 375
attributes, changing, 377–385
baseline shift, 381
bounding box, transforming, 386
converting, point/paragraph, 378
deleting, 376
editable, 373, 374–375
editing, 376
editing mode, exiting, 376
embossed leather, 406
fading, 380
font family/style, changing, 377
font size, changing, 378
formatting, 383–385
hyphenation, 382
importing as Smart Object, 375
justifying, 382
kerning, 379
leading, 380
orientation, 380
paragraph, 374, 378, 386
paragraph settings, 382
point, 374, 378
rasterizing, 388–389
recoloring, 377
repositioning, on image, 387
rusted metal, 404–405
scaling, 378
screening back layers with, 387
selecting, 376
special characters, 381
in spot color channel, 390
tracking, 379

transforming, 348–349, 378
warp settings, 356

Type preferences, 375, 471
type styles

applying, 383
copying between documents, 385
creating, 383
default, creating and loading, 385
editing, 384
formatting type with, 383–385
loading between documents, 385
overrides, clearing, 384

U
undo shortcuts, 109
Units & Rulers preferences, 16, 469
Unsharp Mask filter, 339–340
updating Photoshop, 499
uploading 

files to Behance, 500
files to the Creative Cloud, 498–499
preferences and presets to the 

Creative Cloud, 497–498

V
vector masks

applying to its layer, 190
converting to layer masks, 415
copying, 190
creating by drawing path, 414
creating from existing path, 413
creating from shape layer, 413
creating from type, 414
disabling or deleting, 190
function, switching, 415
loading as a selection, 190
moving to another layer, 190
repositioning, 415

vector objects

aligning to the pixel grid, 408
anchor points, adding/deleting, 

422–423
creating, 407–408
defined, 407
points, converting, 422
reshaping, 422–423
saving as custom shape, 421
segments, reshaping, 422
See also paths, shape layers

Vertical Type tool

in changing font size, 378
creating type with, 374–375
defined, 113
recoloring type with, 377
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selecting type with, 376
Vibrance adjustments, 233–235
video

adding still images to, 455
adjustment layer application to, 455
audio clips, 458
files, importing, 452
filter application to, 457
frames, 451
keyframes, 451
manual fade, 457
picture-in-a-picture, 457
playing, 453
rendering clips, 458
reviewing, 453
terminology, 451
timeline, 451, 452
title clips, 455
tracks, 451, 452, 453
transitions, 451

video clips

adding transitions to, 454
applying adjustment layer to, 456
applying filters to, 457
defined, 451
deleting, 453
length and speed specification, 453
order, changing, 453
rendering, 458
splitting, 454
title, 455
trimming by dragging, 453

View menu

Clear Guides command, 284
Extras command, 282, 348
Lock Guides command, 284
New Guide command, 284
Proof Colors command, 476, 477
Proof Setup command, 209, 476
Rulers command, 283
Show submenu, 176, 282, 283, 284
Snap command, 283, 284
Snap To submenu, 141, 169, 284

vignettes

creating via Lens Correction filter, 439
creating via tonal adjustment, 438
recording actions that apply, 429
white-bordered, creating, 437

vignettes (Camera Raw)
applying in Effects tab, 85
correcting in Manual tab, 79–81
correcting in Profile tab, 78

W
Warp command, 356
watermarks, adding to images, 442–443
Web output

aligning vector objects for, 408
buttons for, 411
downsampling images for, 137
GIF and JPEG compared, 491
GIF format, 493–494
JPEG format, 495–496
previewing optimization settings, 492
resolution and dimensions for, 13, 16

white balance

adjustments (Camera Raw), 63
setting (Camera Raw), 62

White Balance tool (Camera Raw), 57
white point, calibration, 7
Window menu

Arrange submenu, 97, 98, 100, 254, 260
Brush Presets command, 291
Character command, 377
Options command, 108, 111, 126
Workspace submenu, 102, 451

Windows

droplet usability in, 430
exiting Photoshop in, 22
launching Bridge in, 23
launching Photoshop in, 1
Save As dialog, 19
ZIP file creation, 490

Work Paths, 416, 417
Workflow Options dialog (Camera 

Raw), 60
working spaces

CMYK, 485
current, assigning, 12
settings, 8

Workspace menu (Options bar),  
102, 106, 107, 108

workspaces

choosing, 102
deleting, 107
editing, 107
resetting, 107
saving, 106–107
setting up for video editing, 451

workspaces (Bridge)
choosing, 28–29
custom, 38
default, 26
deleting, 38
Essentials, 28, 29

Filmstrip, 28
Light Table, 28, 29
order, changing, 28
Preview, 28, 29
resetting, 38
saving, 38

wrinkle removal, 308, 309, 312

Z
ZIP files, 490
zoom

level, changing, 99–101
level, changing via Navigator  

panel, 100
level, changing with Zoom tool, 99
level, matching in multiple 

documents, 100
in multiple document windows, 101
shortcuts, 99

Zoom tool

defined, 114
Scrubby Zoom, 99
zoom level changes with, 99, 101
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